
4 Basic Device 
Operations

Preparing the printer 
to print

2 Setting Up

Before 
useUser's Manual

Basic

C911dn
C931dn
C941dn
ES9411dn
ES9431dn
ES9541dn 

○This manual contains cautions on how to use this product safety. 
Before you use this product, please make sure that you read this manual. 　
○Carefully store this manual close to hand so.

1

Appendix

Index

3 Printing

 

 

 

 

 

 



- 2 -

zz Manual Configuration
The following user manuals are enclosed with the product.

The e-manual is stored on the "Software DVD-ROM".

4 Basic Device Operations

Preparing the printer
to print 2 Setting Up

Beforeuse

User's Manual

Basic

C911dnC931dnC941dnES9411dnES9431dnES9541dn
○This manual contains cautions on how to use this product safety. 

　Before you use this product, please make sure that you read this manual.

○Carefully store this manual close to hand so.

1

Appendix

Index

3 Printing Basic (This manual)
Preparing the printer to print

Try using various functions

Read for any points that are not understood, or for maintenance

Using C941/ES9541dn

This guide describes the precautions for safe 
use of the device. Make sure to read before use. 
Further, basic uses from the device installation 
methods to initial printing are also explained. 
The device functions are described in the 
appendix.

Read these guides as necessary

Advanced

2Step

This guide explains the various paper print methods 
and how to use useful functions. Read to optimize the 
printing environment or to adjust the color, etc., using 
the enclosed utility software. 
Further, this guide also explains the items that can be 
set from the control panel, and the network settings.

Troubleshooting/Daily 
Maintenance Manual
This manual explains the procedures for paper and paper jams, 
and troubleshooting method if an error message is displayed. 
This manual also explains daily maintenance such as now to 
replace consumables and maintenance units, and cleaning, etc.

• Troubleshooting
• Maintenance
• Consumables, maintenance products, 
   options, color management server, 
   etc.

・Pamphlet
・E-format

・E-format

・Pamphlet
・E-format

Read this first

Easy Guide (Set-up Guide)
Opening the box and installing the printer

1Step

This guide uses illustrations to explain the 
methods from opening the box to installation. 
For the advanced setup guide, see the "Basic".・Pamphlet

• Checking the product
• Parts nomenclature and functions
• Using the device to its fullest
• Installing the device
• Turning ON and OFF the power supply
• Test printing using the printer only
• Connecting to a PC
• Paper
• Printing
• Paper ejection
• Setting Power Save mode
• Setting auto power OFF
• Checking the print quantity, 
   consumables, remaining maintenance 
   unit quantity, and remaining service life
• Cancelling a print job
• Adding printers using LPD protocols 
  (TCP/IP)
• Table of control panel menu items
• Basic Windows procedures
• Printer specifications

• Useful print functions
• Adjusting the color
• Using utility software
• Network settings
• Checking and changing printer settings 
   using the control panel

Separate Volume  Spot Color Guide
This guide explains how to set up the Spot 
Color kit and check the printer drivers, and 
how to print using Spot Color. Make sure to 
read before use. 

• Setting the Spot Color kit
• Control panel explanation
• Checking the printer drivers
• Table of printer driver functions
• Printing on color paper
• Printing on transparent film
• Specifying and printing Spot Color 
   toner using the applications
• Fine-tuning white
• Switching Spot Color kits

・Pamphlet
・E-format

1040 mm
41 inch

620 mm
24.4 inch

200 mm
7.9 inch

600 mm
23.6 inch

91.6 kg
202 lb

91.6 kg
202 lb

45583101EE Rev1

2

C911dn/C931dn/E9411dn/ES9431dn Set-up Guide

1 3

4 5 6 7

8 9 10

Read for any points thatare not understood, orfor maintenance

1 Troubleshooting

2 Maintenance

Index

User’s Manual

Troubleshooting/DailyMaintenance Manual

C911dnC931dnC941dnES9411dnES9431dnES9541dn
○Store this manual carefully close to hand so it can be viewed at any time.

User’s Manual

C941dnES9541dn

Separate Volume  Spot Color Guide
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zz About the Enclosed "Software DVD-ROM"
When the "software DVD-ROM" enclosed with the device is placed in the DVD-ROM drive, the following 
menu screen will be displayed.

Memo

zz This example uses the Windows screens.

zz If using a Macintosh, double-click the [OKI] icon.

Describes the selected 
printer and PC connection 
type.

Click here to install the standard 
printer drivers.

You can add and select printer 
drivers.

To learn the easy device functions 
and various settings, see the PDF 
manual from here. *2

You can install and set the device 
utility software.

Select the printer 
model.

Select the device and 
PC connection method.

You can register as 
a user from the OKI 
Data homepage. *1

Close the "Software 
DVD-ROM".

*1: Access is only possible using an internet-enabled environment.

*2: To view the PDF manual, Adobe Reader/Adobe Acrobat Reader is required.



- 4 -

zz Reading the Manual

Symbols

Note

zz These are cautions and restrictions for the correct operation of the device. Make sure to read to avoid misoperation.

Memo

zz Knowledge of the information before using the device is useful and can act as a reference. Reading is recommended.

Reference

zz These are the reference pages. Read to learn detailed information and relevant information.

DANGER
zz Mishandling due to ignoring this display may cause death or serious injury.

WARNING
zz Mishandling due to ignoring this display may cause death or serious injury.

CAUTION
zz Mishandling due to ignoring this display may cause personal injury.

Keys, Buttons, and Symbols
This chapter described the following keys, buttons, and symbols.

Inscription Explanation

[...] button/key

zz The control panel buttons and 10-key pad are described below.
E.g.:

  [OK] button		    [BACK] button

 [Fn] key		    [CLEAR] key

zz Indicates your PC keyboard.

[         ] zz Describes the menu name on the liquid crystal panel.
zz Describes the PC menus, windows, and dialog box names.

"         "

zz Describes the messages and input text displayed in the liquid crystal 
panel.

zz Describes the file and screen names on the PC.
zz Describes the reference title.

> Describes the menu level of the device or PC.
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Illustrations
The device illustrations used herein show the 
C931 model unless otherwise specified.

Illustrations may differ from the actual product.

Screens
The images of the control panel and PC used 
herein are examples. The images may differ 
from actual products and screens.
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Inscriptions
The following inscriptions are used in this manual.

zz C911dn → C911

zz C931dn → C931

zz C941dn → C941

zz ES9411dn → ES9411

zz ES9431dn → ES9431

zz ES9541dn → ES9541

zz Microsoft® Windows® 7 64-bit Edition operating system → Windows 7 (64bit version)

zz Microsoft® Windows® 7 operating system → Windows 7

zz Mac OS X10.3.9 or later → Mac OS X
The manuals enclosed with the device use as examples Windows 7 in the case of Windows and OS X 
10.8 in the case of Mac OS X unless otherwise specified.

Depending on the OS and model used, descriptions in this manual may differ.
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zz About the Product Warranty
Every effort has been made to ensure that the information in this document is complete, accurate, 
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its 
control. The manufacturer also cannot guarantee that changes in software and equipment made by 
other manufacturers and referred to in this guide will not affect the applicability of the information 
in it. Mention of software products manufactured by other companies does not necessarily constitute 
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as possible, 
we make no warranty of any kind, expressed or implied, as to the accuracy or completeness of the 
information contained herein.

All rights are reserved by Oki Data Corporation. You must not copy, transfer, translate, etc. the content 
herein without authorization. You must obtain written permission from Oki Data Corporation before 
doing any of the above.

© 2013 Oki Data Corporation

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft 
Corporation.

Apple, Macintosh, Rosetta, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their proprietors.

As an ENERGY STAR ® Program Participant, the manufacturer has determined that this 
product meets the ENERGY STAR guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2004/ 108/EC (EMC), 
2006/95/EC (LVD),1999/5/EC (R&TTE), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as 
amended where applicable, on the approximation of the laws of the member states relating 
to Electromagnetic Compatibility, Low Voltage, Radio & Telecommunications Terminal 
Equipment, Energy related Products and Restriction on the use of certain Hazardous 
Substances in electrical and electronic equipment.

The following cables were used to evaluate this product to achieve EMC directive 
2004/108/EC compliance and configurations other than this may affect that compliance.

cable type length
(meters) core shield

Power 1.8  

USB 5.0  

LAN 15.0  
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zz Emergency first aid
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO 
NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes 
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of 
staining skin or clothing.

zz Manufacturer
Oki Data Corporation, 
4-11-22 Shibaura, Minato-ku, 
Tokyo 108-8551, 
Japan

For all sales, support and general enquiries contact your local distributor.

zz Importer to the EU/Authorized representative
OKI Europe Limited (trading as OKI Printing Solutions)

Blays House 
Wick Road 
Egham 
Surrey, TW20 0HJ 
United Kingdom

For all sales, support and general enquiries contact your local distributor.

zz Environmental information
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zz For Your Safety
Read the User’s Manual for your safety before using the product.

Cautions related to safety

WARNING A warning provides additional information which, if ignored, may result in a risk of personal injury.

CAUTION A caution provides additional information which, if ignored, may result in equipment malfunction 
or damage.

General cautions

WARNING

Do not touch the safety 
switch inside the machine. 
Doing so may cause electric 
shock when high voltage 
occurs. In addition, gears can 
rotate, which may result in 
personal injury.

Do not use an inflammable 
spray near the machine. 
Doing so may cause fire 
since there is an area heating 
up within the machine.

Pull the power plug out of 
the socket and contact with a 
customer’s service centre when 
the cover is unusually hot, 
smoking, giving off questionable 
odour, or making a strange noise.
Failure to do so may cause fire.

Pull the power plug out of 
the socket and contact with 
a customer’s service centre 
when a liquid such as water 
enters in the internal parts of 
the machine.
Failure to do so may cause 
fire.

Pull the power plug out of the 
socket and remove foreign 
materials such as clips when 
they fall inside the machine.
Failure to do so may cause 
electric shock and/or fire 
leading to personal injuries.

Do not operate and/or 
disassemble the machine 
other than that directed in 
User's Manual.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Unplug the power cord and 
contact with a customer’s 
service center if the machine 
is dropped or the cover is 
damaged.
Failure to do so may cause 
electric shock and/or fire 
leading to personal injuries.

Unplug the power cord 
periodically to clean plug 
blades and root section 
between the blades. If the 
power plug remains inserted 
for a long time, the root 
section will get dusty, and 
the plug may be shorted out, 
which may cause fire.

Do not clean spilled toner with 
a vacuum cleaner.
If cleaning spilled toner with a 
vacuum cleaner, it may catch 
fire due to the sparks from 
electric contact.
Toner spilled on the floor 
should be wiped off with wet 
cloth.

Do not insert materials in a 
vent hole.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not put a cup with liquids 
such as water on the machine.
Doing so may cause electric 
shock and/or fire leading to 
personal injuries.

Do not touch the fuser and 
other parts when opening the 
cover of the machine.
Doing so may cause burns.

Do not throw toner cartridges
and image drum cartridges
into fire. Doing so may cause
dust explosion leading to
burns.

Do not use a power cord, a 
cable, or a ground wire other  
than those that are indicated 
in User's Manual.
Doing so may cause fire.

The operation of using UPS 
(uninterruptible power source) 
or inverters is not guaranteed. 
Do not use uninterruptible 
power source or inverters.
Doing so may cause fire.

CAUTION

Do not come closer to the paper’s exit area when 
the power is turned on, while printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquid-
crystal display gets into the eyes or mouth, flush 
with large amount of water. Follow the direction 
from a doctor if necessary.
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When installing or moving

WARNING

For the U.S.A. and Canada
Multifunctional Digital Systems require 110 to 127 V, 10 A, 50/60 Hz electric power.

For the EU

Multifunctional Digital Systems require 220 to 240 V AC, 5 A, 50/60 Hz electric power.

Except the U.S.A., Canada and the EU

Multifunctional Digital Systems require 220 to 240 V AC, 5 A, 50/60 Hz electric power.

zz Do not use a power supply with a voltage other than that specified.  
Avoid multiple connections in the same outlet. This could cause a fire or give you an electric shock. If 
you are considering increasing the number of outlets, contact an electrician.

zz Always connect this machine to an outlet with a ground connection to avoid the danger of fire or 
electric shock in case of short-circuiting. Contact your service representative for the details. Be sure 
to use a 3-conductor, grounded wall outlet. 
In areas, except the U.S. and Canada, where a 2-pin plug is used, the machine must be grounded for 
safety. Never ground it to a gas pipe, a water pipe, or any other object not suitable for grounding.

zz Plug the power cord securely into the outlet. If it is not plugged in properly, it could heat up and 
cause a fire or give you an electric shock.

zz Do not damage, break or attempt to repair the power cord. 
The following things should not be done to the power cord. 
 _ Twisting it 
 _ Bending it 
 _ Pulling it  
 _ Placing anything on it  
 _ Heating  
 _ Situating it near radiators or other heat sources 
This could cause a fire or give you an electric shock. If the power cord is damaged, contact your 
dealer.

zz The socket outlet shall be near the equipment and be easily accessible.

zz Pull out the plug from the outlet more than once a year to clean around the prongs. Accumulating 
dust and dirt could cause a fire due to the heat released by electric leakage.
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CAUTION

zz When removing the plug from the outlet, do not pull the power cord. Always hold the plug when 
removing it from the outlet. If the power cord is pulled, the wires may break and this could cause a 
fire or give you an electric shock.

zz Make sure that the ventilation holes are not blocked.  
If the temperature within the machine becomes too high, a fire could result.

��Other points

zz Be sure to fix the power cable securely so that no one trips over it.

zz Adverse environmental conditions may affect the safe operation and performance of the machine, 
and the machine could break down.

_ Avoid locations near windows or with exposure to direct sunlight.
_ Avoid locations with drastic temperature fluctuations.
_ Avoid too much dust.
_ Avoid locations that suffer from vibration.

zz Make sure that the air is able to flow freely and that there is sufficient ventilation. Without adequate 
ventilation, the unpleasant odor released by ozone will begin to dominate the atmosphere.

When using the machine

WARNING

zz Do not take off the cover of the equipment; otherwise you could be injured or get an electric shock.

zz Do not remove or connect the plug with wet hands, as this could give you an electric shock.

zz Do not place any container with liquid (flower vases, coffee cups, etc.) on or near the equipment. 
This could cause a fire or give you an electric shock.

zz Keep paper clips and staples away from the air vent. If not, a fire could result or you could get an 
electric shock.

zz If the machine becomes excessively hot, smoke comes out of it or there is an odd smell or noise, 
proceed as follows.  
Turn the main power switch OFF and remove the plug from the outlet, then contact your service 
representative.

zz If the machine will not be used for more than one month, remove the plug from the outlet for safety purposes 
during that time. If an insulation failure occurs, this could cause a fire or give you an electric shock.

CAUTION

zz Do not place heavy objects (8 Kg/18 lb. or more) on the original glass and do not press on it with 
force. Breaking the glass could cause personal injury.

zz Do not place heavy objects (8 Kg/18 lb. or more) on the machine. If the objects fall off, this could cause injury.

zz Do not touch the fuser unit or the metal area around it. Since they are very hot, you could be burned 
or the shock could cause you to injure your hand in the machine.

zz Be careful not to let your fingers be caught when closing the tray. This could cause an injury.

zz Be careful not to let your fingers be caught between the equipment and the duplexing unit or 
automatic duplexing unit. This could cause an injury.

zz Do not touch the metal portion of the guide plate in the duplexing unit or automatic duplexing unit as 
it could burn you.

zz Do not touch the hinge (= a connecting part) on the rear side of the Reversing Automatic Document 
Feeder. This could catch and injure your fingers when you open or close the Reversing Automatic 
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Document Feeder.

zz Always keep hands and fingers clear of the finisher tray hinge, as the tray could move unexpectedly. 
Failure to do so could result in injury to your hand and/or fingers.

zz Do not use the pulled out tray as steps. This could injure you if you fall.

zz When changing the angle of the control panel, be careful not to catch your hands in the gap between 
the equipment and the control panel. This could cause personal injury.

zz Do not place objects of weighing 3.3 kg/7.3 lb. or more on the optional work table. Breaking the 
work table could cause personal injury.
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��Other points

zz Be very careful to treat the touch panel gently and never hit it. Breaking the surface could cause 
malfunctions.

zz Be sure to turn the power OFF when leaving the office or if there is a power outage. However, do not 
turn the power OFF if the weekly timer is in use.

zz Be careful because the paper exit area and paper just after exiting are hot.

zz Do not place anything other than paper on the receiving tray. This could disturb a normal operation 
and cause malfunctions.

zz Do not touch the photoconductive drum and transfer belt. This could cause image problems.

zz Do not open/close the covers and the MPT, or pull out the trays during printing.

During maintenance or inspection

WARNING

zz Never attempt to repair, disassemble or modify the machine by yourself. You could cause a fire or get 
an electric shock.

zz Do not let liquids such as water and oil get into the machine when cleaning the floor. This could cause 
a fire and give you an electric shock.

CAUTION

zz Always keep the plug and outlet clean. Prevent them from accumulating dust and dirt. This could 
cause a fire and give you an electric shock due to the heat released by electric leakage.

zz Do not touch the stapling area. The actual needle point could cause you personal injury.

��Other points

zz Do not use such solvents as thinner or alcohol when cleaning the surface of the machine.
_This could warp the shape of the surface or leave it discolored.
_When using a chemical cleaning pad to clean it, pay attention to any cautionary points.
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When handling supplies

CAUTION

zz Never attempt to incinerate toner cartridges and waste toner boxes. Dispose of used toner cartridges 
and waste toner boxes in accordance with local regulations.

��Other points

zz Read the user's manual carefully to replace the toner cartridge using the correct procedure. An 
improper procedure could cause toner leakage or scattering.

zz Do not open the toner cartridge forcibly. This could cause toner leakage or scattering.

zz Keep the toner cartridge out of the reach of children.

zz If toner is spilt on your clothes, wash it off with cold water. If you use warm water, your clothes will 
be permanently stained with toner because it will not come out.

zz If toner leaks from the toner cartridge, be careful not to inhale or touch it.

First-aid measures
If you inhale or touch toner, etc; carry out the following treatment.

zz Inhalation: Remove from exposure area to fresh air immediately. Contact a physician if there is 
any difficulty in breathing or other signs of distress.

zz Skin Contact: Wash with soap and water. Wash clothing before reuse. If irritation occurs or is 
persistent, seek medical attention.

zz Eye Contact: Immediately flush eyes with plenty of water for at least 15 minutes. If irritation 
persists, call a physician.

zz Ingestion: Dilute stomach contents with several glasses of water.
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Viable with C911/C931/C941/ES9411dn/ES9431dn/ES9541dn

zz Viable with C911/C931/C941/ES9411dn/
ES9431dn/ES9541dn

Colo
r Abundant color matching functions 

can be used

The device has functions to 
compensate color misalignment and 
density using the control panel, and 
can adjust the color balance. Further, 
colors can be adjusted, the print 
results simulated, and the colors 
separated and printed using the color 
management system from the PC.

Prin
t Various printings are possible 

using the convenient functions

Various printings are possible using 
the device convenient functions when 
printing from a PC.

App
ri-

catio
n

It is possible to print from various 
applications

The built-in Adobe PostScript3, 
PCL6 emulation, and XPS emulation 
enable printing from a wide range of 
applications.

PostScript3 
and 

PCL6 Compatible
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Viable with C911/C931/C941/ES9411dn/ES9431dn/ES9541dn

Netw
ork Usable as a network printer

High-quality, high-speed printing is 
possible from various applications. 
(With A4 , 50 sheets a minute using 
color/monochrome printing.) As it 
is possible to connect to a network 
and print from multiple PCs, office 
space saving and cost reductions are 
achieved.

(This manual page 61)

Pan
el

The printer status can be checked, 
and error messages and help 
displayed, on the control panel

Either "Remaining toner quantity 
display" or "Tray information display" 
can be displayed in the control panel 
standby screen. If an error occurs 
in the device, you can work while 
checking the control panel messages.

(This manual page 31)

Funct
ion Functions can be set using the 

control panel

Various device functions can be set 
such as changing paper size and 
network setup from the control panel. 
Further, administrator passwords can 
also be set using the control panel.

Powe
r

savin
g

Power consumption is reduced 
when the printer is not in use 
(Power save mode)

If the device is not used for a fixed 
period of time, power save mode 
starts automatically (power save 
mode/sleep mode) to enable power 
consumption to be reduced. Press the 
[POWER SAVE] button to enter power 
save mode manually. When in sleep 
save mode, the [POWER SAVE] button 
is lit green.

(This manual page 111)

Power 
consumption
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Viable with C911/C931/C941/ES9411dn/ES9431dn/ES9541dn

Opti
on Increasing the quantity of paper 

that can be fed

Mounting the optional expansion 
tray unit enables the continuous 
printing of large quantities and the 
printing of different paper sizes to be 
implemented smoothly.

(This manual page 38)

Help
Use the help function to check if 
you do not understand something 
or if trouble occurs when using 
the device
Press the [HELP] button on the 
control panel to display messages 
for resolutions if trouble occurs, and 
how to troubleshoot. (Animations will 
be displayed depending on the error 
details.)

(This manual page 34) 
(Troubleshooting/Daily Maintenance 
Manual)
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Viable with C911/C931/C941/ES9411dn/ES9431dn/ES9541dn

��Memo
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1. Before use
This chapter explains the package contents of the product and the nomenclature and functions of the parts.

Note

zz The C941/ES9541dn Spot Color kit is a separate package. For the set-up method, see the "Separate Volume  Spot Color Guide".

zz Checking the product

Checking the Package 
Contents

Open the packing case and check the contents of 
the box.

CAUTION There is a risk of injury.

zz C911/C931/ES9411dn/ES9431dn models 
weigh approx. 97kg*, and C941/ES9541dn 
models weigh approx. 117Kg*, so make sure 
to use at least 4 people minimum when lifting.

*: Includes consumables such as the image drum and 
toner cartridge, etc.

Reference

zz See “Opening the Package and Installation” (P.44) for 
how to open the package.

zz See “Mounting the Expansion Unit (Optional)” (P.50) for 
the expansion tray.

zz Printer Unit

Memo

zz A maximum of five optional expansion tray units 
(trays 2 to 5) can be mounted to C911/C931/C941/
ES9411dn/ES9431dn/ES9541dn.

zz Toner cartridge (One each of black, yellow, 
magenta, and cyan)

zz Image drum (One each of black, yellow, 
magenta, and cyan)

Note

zz The image drum is set inside the main unit before 
shipment from the factory.

zz Software DVD-ROM

zz Easy Guide (Set-up Guide)

1040 mm
41 inch

620 mm
24.4 inch

200 mm
7.9 inch

600 mm
23.6 inch

91.6 kg
202 lb

91.6 kg
202 lb

45583101EE Rev1

2

C911dn/C931dn/E9411dn/ES9431dn Set-up Guide

1 3

4 5 6 7

8 9 10

zz User's Manual (Basic).

4 Basic Device 
Operations

Preparing the printer 
to print

2 Setting Up

Before 
useUser's Manual

Basic

C911dn
C931dn
C941dn
ES9411dn
ES9431dn
ES9541dn 

○This manual contains cautions on how to use this product safety. 
Before you use this product, please make sure that you read this manual. 　

○Carefully store this manual close to hand so.

1

Appendix

Index

3 Printing

zz User's Manual (Troubleshooting/Daily 
Maintenance Manual)

Read for any points that
are not understood, or
for maintenance

1 Troubleshooting

2 Maintenance

Index

User’s Manual

Troubleshooting/Daily
Maintenance Manual

C911dn
C931dn
C941dn
ES9411dn
ES9431dn
ES9541dn

○Store this manual carefully close to hand so it can be viewed at any time.
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Note

zz LAN cables, USB cables, and hubs are not included with 
the printer. Prepare them separately.

zz The packing case and buffer material are required when 
shipping the device. Do not discard them, but store them 
safely.
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zz Parts Nomenclature and Functions

Main Unit

Front/Right Side

Toner replacement cover
Open this to replace the toner cartridge.

Face down stacker
The printed sheets are placed printed-side down and 
discharged.

Control Panel
Displays the device status and menus, and sets the 
functions.
“Control Panel” (P.31)

Right side cover
Open this to replace the multi-purpose tray feed 
roller, and to clear paper jams.

Front lamp
Flashes when receiving data and while in power save.

Tray side cover
Open to clear paper jams from trays 1 to 5.

Front cover
Open this to remove the image drum, waste toner 
box, and belt unit.

Carrying handles
Hold these at the same time as the carrying lever 
when carrying the device.

Power switch
zz You can turn ON and OFF the power supply when 
the main power switch is ON.

zz Cancels the OFF mode.

Carrying lever
When carrying the device, pull out this lever, and 
hold the carrying handles at the same time.

Tray 1/Paper cassette
This is the paper tray mounted as standard. Plenty of 
paper can be set at one time.
Set the print surface face-down.

Opener
Open the right side cover.
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Back/Left Side

Interface
There are a LAN (network) interface connector and a 
USB interface connector. See “Interface” (P.30) for 
the interfaces.

Exit unit
Open this when replacing the fixing unit or transfer 
roller unit, or to clear paper jams.

Access cover
Open this when mounting the optional built-in HDD.

Duplex print unit
Implements duplex printing.

Carrying handles
Hold these at the same time as the carrying lever 
when carrying the device.

Carrying lever
When carrying the device, pull out this lever, and 
hold the carrying handles at the same time.

Power connector
Connect the enclosed power cable here.

Main power switch
Turns ON and OFF the device main power supply.

Left side cover
Open this to clear paper jams.
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Printer Interior

Front Interior

Toner cartridge
zz The remaining toner quantity is normally displayed 
when "Display remaining toner quantity" has been 
set using the control panel standby screen.

zz The toner cartridge is a consumable.

Slot
Set the toner cartridge here.
“Mounting Consumables” (P.46)

Belt unit
This device copies the toner to the paper.
The belt unit is a replaceable maintenance part.

Handle
Hold this handle when removing the belt unit.

Lock lever knob
Secures the belt unit.

Image drum/Slot
zz The image drum is set in the slot.
zz The image drum is set inside the printer main unit 
before shipment from the factory.

zz The image drum is a consumable.

Belt unit lock lever
Secures the belt unit.

Waste toner box
This box holds the waste toner.
When the waste toner box is full, a message is 
displayed on the control panel. The waste toner box 
is a replaceable maintenance part.

Belt unit lever
Secures the belt unit.
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Right Side Interior

Multi-purpose tray/MP tray
You can print on various papers, including postcards 
and envelopes, etc.
Further, use when printing to the topside of the 
paper that has been set. Set the paper size using the 
control panel when using as a  regular tray.

Supplementary supporter
Maintains the paper when paper has been set in the 
multi-purpose tray.

Paper guide
Stabilizes the paper by adjusting the paper guide to 
the width of the paper to be printed.

Paper supporter
Sets the paper to be printed in the multi-purpose 
tray.
Sets the print surface face-up.

Set lever
Move the paper guide left and right while pulling the 
lever towards you when adjusting the paper guide to 
the width of the paper. The paper guide is secured 
when the set lever is returned to its original position.
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Left Side Interior

Face-up stacker
Open the stacker to set and eject the paper face-up.

Paper supporter
Secures the paper ejected to the face-up stacker.

Supplementary supporter
Secures so that the ejected paper does not droop.

Fixing unit
This unit fixes the toner to the paper.
The fixing unit is a replaceable maintenance part.

Fixing unit securing lever
Secures the fixing unit.

Fixing unit jam cancellation lever
Pull up this lever when a paper jam occurs in the 
fixing unit.

Transfer roller unit
Transfers the toner to the paper.
The transfer roller unit is a replaceable maintenance 
part.

Output unit knob
Pull this knob towards you, and pull out the output 
unit.

Transfer roller unit fixing lever
Secures the transfer roller unit.

Output unit
The fixing unit, transfer roller unit, and duplex print 
unit are mounted to this unit.
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Interface

LAN (network) interface connector
Connects the LAN cable.

USB interface connector
Connects the USB cable.
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Control Panel

Liquid crystal panel
zz Displays the device status and menus.
zz There are two types of standby screen: "Remaining 
toner quantity display" and "Tray information 
display".

ATTENTION lamp
Displays the device status.
Normally OFF.
Lit or flashes orange if an error occurs.

[HELP] button
Displays the help screen.
Lit orange when help messages can be referenced, 
such as explanations of the error that has occurred 
or the cancellation procedure.

Scroll button (MENU button)
zz Displays the menu screen to select an item, and 
then scrolls up (or down) one page.

zz Can be used to enter numbers in the numerical 
input screen.

[BACK] button
Returns to the previous page.

[ON LINE] button
zz Switches between online and offline.
zz Lit green when online, and OFF when offline.

[OK] button (MENU button)
Determines the selected item and set values.

Ten-key pad (1 to 0, *, C)
zz Use to enter numerical values and passwords.
zz Press the [*] ([Fn]) key in the standby screen to 
display the "function number input" screen, and to 
enter menu items directly.

[POWER SAVE] button
zz Turns ON and OFF power save mode.
zz Cancels sleep mode.

[CANCEL] button
Use to cancel a print, or to cancel the settings.
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Main Control Panel Features

The control panel can be used to check the device status and implement various device functions.

The toner cartridge can be replaced while viewing the liquid crystal display on the control panel. 
Further, you can also perform operations while checking the messages displayed on the liquid crystal 
panel if paper jams or device malfunctions occur.

Reference

zz See the control panel menus table “Table of control panel menu items” (P.125).

Control Panel Appearance

This section explains the main control panel operations and control panel appearance.

There are two types of standby screen: "Remaining 
toner quantity display" and "Tray information display".

Press the scroll button  or the  to display the "Functions 

setup" menu screen as shown on the right.

The color display of the selected item is inverted.

The name of the menu that is displayed.

Displays the number of pages in the menu 
displayed on the liquid crystal panel.

If there is a scroll bar, there are items that are 
not displayed in the liquid crystal panel. Press 
the scroll button  or  to display them.

A password must be entered to display the [Admin 
Setup]. Enter the administrator password (factory 
setting is "aaaaaa") in the password input screen.

zz If there is a selection menu at the next level or set values for an item, select the item and press the 
[OK] button to display the next screen.

zz If a set value is displayed, press the [OK] button to confirm the value that has been set. (  is 
displayed to the left of the value.)



- 33 -

Parts Nomenclature and Functions

A
p
p
en

d
ix

B
efo

re u
se

1

S
ettin

g
 U

p

2

Prin
tin

g

3

Basic D
evice O

perations

4

In
d
ex

��Standby Screen
There are two types: "Remaining toner quantity 
display" and "Tray information display".

Use the following procedure to switch the 
standby screens.

1	 Press either the scroll button  or  
on the control panel to display the 
"Functions" screen.

2	 Press the scroll button  several times 
to select the [Admin Setup], and then 
press the [OK] button.

3	 Use the 10-key pad to enter the 
administrator password.  
The default factory-set password is 
"aaaaaa". Press the [OK] button after 
entering each individual character.

4	 Press the [OK] button.

5	 Press the scroll button  several times 
to select [Panel Setup], and then press 
the [OK] button.

6	 Press the scroll button  several times 
to select the [Idle Display], and then 
press the [OK] button.

7	 To display the "remaining toner 
quantity" in the standby screen, select 
[Toner Gauge], and then press the [OK] 
button.  
To display the "tray information", select 
[Paper Size], and then press the [OK] 
button.

8	 Press the [ON LINE] button to return to 
the standby screen.
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��Error Screen
If a printer error occurs, the maintenance lamp 
will either turn ON or flash, and a message will 
be displayed in the liquid crystal panel.

Depending on the error, the error countermeasure 
and animations may be displayed in the liquid 
crystal panel in addition to the message.

Reference

zz "Troubleshooting/Daily Maintenance Manual"

Press the control panel buttons in the error 
screen to set the device to the following 
statuses.

[POWER SAVE] button:

The printer will enter power save mode. Press 
the [POWER SAVE] button when the device is 
in power save mode to return to the standby 
screen.

[HELP] button:

Press the [HELP] button when it is lit to display 
the relevant help message for the error that is 
currently displayed.

[OK] Button:

In the case of errors for which the error message 
vanishes when the [OK] button is pressed, the 
printer will return to the standby screen.

[ON LINE] button:

In the case of errors for which the error message 
vanishes when the [ON LINE] button is pressed, 
the printer will return to the standby screen.

[CANCEL] button:

The following errors can be cancelled.

zz There is no paper in the multi-purpose tray

zz Change the paper in [Tray name]

zz There is no paper in [Tray name]

zz Check the paper in [Tray name]

zz Paper size error

zz Change the multi-purpose tray paper

zz Insufficient print data memory

zz Toner empty

zz Multiple sheets of paper have been fed

zz The [tray name] cassette is missing

zz  Feed print job manually

��Help Screen
Press the [HELP] button to display the help 
screen. Further, press the [HELP] button when it 
is lit to display the relevant help message for the 
error that is currently displayed.

Press the  scroll button  displayed in the help 
screen to scroll to the previous page. Press the 

 scroll button to scroll to the next page.

To close the help screen, press the [HELP] button 
again.

Memo

zz Press and hold either the  scroll button or  to scroll 
through the pages at approx. 0.5-second intervals.

zz The help screen can also be closed by pressing the [BACK] 
button, [ON LINE] button, or [CANCEL] button.
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Adjusting the Control Panel 
Brightness

Use the following procedure to adjust the 
brightness of the liquid crystal panel.

Memo

zz The brightness (backlight) of the liquid crystal panel can 
be set individually for during control panel operations and 
when in power save mode.

1	 Press either the scroll button  or  
on the control panel to display the 
"Functions" screen.

2	 Press the scroll button  several times 
to select the [Admin Setup], and then 
press the [OK] button.

3	 Use the 10-key pad to enter the administrator 
password. The default factory-set password is 
"aaaaaa". Press the [OK] button after entering 
each individual character.

4	 Select [Panel Setup], and press the [OK] 
button.

5	 When adjusting the brightness for 
during control panel operations, select 
[Panel Brightness During Operating], 
and press the [OK] button.

When adjusting the brightness for when in 
power save, select [Panel Brightness While 
Power Save], and press the [OK] button.

6	 Press the [ON LINE] button to return to 
the standby screen.
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Using the 10-Key Pad

Use to input alphanumeric characters.

The characters that can be entered when each 
key is pressed, and the toggling of the input 
characters, are described below.

10-key

[1] 1

[2] a → b → c → 2 → a

[3] d → e → f → 3 → d

[4] g → h → i → 4 → g

[5] j → k → l → 5 → j

[6] m → n → o → 6 → m

[7] p → q → r → s → 7 → p

[8] t → u → v → 8 → t

[9] w → x → y → z → 9 → w

[0] 0

The following two key functions are as described 
below.

[Fn] key:

Use to display the function number shortcut. 
(Enabled when the standby screen is displayed.)

[CLEAR] key:

Conceals each character individually when 
entering a password.

Memo

zz If entering "abc", press the buttons in the 
following order: [2]→[OK] button→[2]→[2]→[OK] 
button→[2]→[2]→[2]→[OK]

�� Function Number Input Screen
When "Ready To Print" is displayed in the 
standby screen, press the [Fn] key and then 
press the desired number to display the relevant 
menu item.

1	 Press the [Fn] key.

2	 The function number input screen will 
be displayed, so use the 10-key pad 
to enter the (3-digit) menu number to 
be displayed, and then press the [OK] 
button.

3	 The menu will be displayed, so check or 
change the set values.
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Function Numbers Table

Function No. Function No. Menu Item

1 Print Secure Job (Encrypted Job)

2 Print Secure Job (Stored Job)

10 Paper Size (Tray 1)

11 X Dimension (Tray 1)

12 Y Dimension (Tray 1)

13 Media Type (Tray 1)

14 Media Weight (Tray 1)

15 A3Nobi Paper (Tray 1)

16 Legal14 Paper (Tray 1)

17 A5LEF/A6/Hagaki Paper (Tray 1)

18 A5SEF/Oufuku Hagaki Paper (Tray 1)

19 Other Size (Tray 1)

20 Paper Size (Tray 2)

21 X Dimension (Tray 2)

22 Y Dimension (Tray 2)

23 Media Type (Tray 2)

24 Media Weight (Tray 2)

25 A3Nobi Paper (Tray 2)

26 Legal14 Paper (Tray 2)

27 A5LEF/A6/Hagaki Paper (Tray 2)

28 A5SEF/Oufuku Hagaki Paper (Tray 2)

29 Other Size (Tray 2)

30 Paper Size (Tray 3)

31 X Dimension (Tray 3)

32 Y Dimension (Tray 3)

33 Media Type (Tray 3)

34 Media Weight (Tray 3)

35 A3Nobi Paper (Tray 3)

36 Legal14 Paper (Tray 3)

37 A5LEF/A6/Hagaki Paper (Tray 3)

38 A5SEF/Oufuku Hagaki Paper (Tray 3)

39 Other Size (Tray 3)

40 Paper Size (Tray 4)

41 X Dimension (Tray 4)

42 Y Dimension (Tray 4)

43 Media Type (Tray 4)

44 Media Weight (Tray 4)

45 A3Nobi Paper (Tray 4)

46 Legal14 Paper (Tray 4)

47 A5LEF/A6/Hagaki Paper (Tray 4)

48 A5SEF/Oufuku Hagaki Paper (Tray 4)

49 Other Size (Tray 4)

50 Paper Size (Tray 5)

51 X Dimension (Tray 5)

52 Y Dimension (Tray 5)

53 Media Type (Tray 5)

Function No. Function No. Menu Item
54 Media Weight (Tray 5)

55 A3Nobi Paper (Tray 5)

56 Legal14 Paper (Tray 5)

57 A5LEF/A6/Hagaki Paper (Tray 5)

58 A5SEF/Oufuku Hagaki Paper (Tray 5)

59 Other Size (Tray 5)

80 Paper Feed Tray

90 Paper Size (MPTray)

91 X Dimension (MPTray)

92 Y Dimension (MPTray)

93 Media Type (MPTray)

94 Media Weight (MPTray)

95 Tray Usage (MPTray)

100 Print Information (Configuration)

101 Print Information (Network)

102 Print Information (Usage Report)

103 Print Information (Error Log)

200 Power Save Time

201 Sleep Time

202 Auto Power Off Time

210 Error Report

220 Print Position Adjust (MPTray)

221 Print Position Adjust (Tray 1)

222 Print Position Adjust (Tray 2)

223 Print Position Adjust (Tray 3)

224 Print Position Adjust (Tray 4)

225 Print Position Adjust (Tray 5)

230 Paper Black Setting

231 Paper Color Setting

232 Trans. Black Setting

233 Trans. Color Setting

234 SMR Setting

235 BG Setting

236 Drum Cleaning

237 Hex Dump

238 Transfer Roller Cleaning

300 Adjust Density  

301 Adjust Registration  

302 Print Color Tuning Pattern

310 Cyan Density

311 Magenta Density

312 Yellow Density

313 Black Density

314 White Density

314 Clear Density
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zz Using the Device to its Fullest Extent

Options
The following options are supplied for the device.

��  Expansion tray units (trays 2/3/4/5)

Expansion tray unit

(Expandable up to 2 levels)

(Model: TRY-C3G1)

Expansion tray unit with casters

(Model: TRY-C3G2)

Large-capacity expansion tray unit

(3 trays in one, with casters)

(Model: TRY-C3G3)

Note

zz If expanding from level 3 upwards, use a large-capacity expansion tray unit.

��  Built-in HDD

(Model: HDD-C3G)
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Color management server
Recommended for users who want greater color management response and advanced Spot Color 
adjustment.

�� Fiery® XF Server Option

Fiery® XF Server Option
(Model: SVR-C3G)
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��Memo
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2. Setting Up
This chapter explains the methods for setting up the device, and for connecting the device to a PC and 
installing the printer drivers.

Note

⿟⿟ Customers who have purchased C941/ES9541dn should also see the "Separate Volume  Spot Color Guide".

Reference

⿟⿟ See the "Fiery XF Sever Quick Start Guide" for the methods of setting up the color management server for models C931/C941/
ES9431dn/ES9541dn.

⿟⿟Installing the Device
For safe and pleasant use of the device, install in a location that satisfied the "installation environment" 
and "installation space" described in the "installation conditions". Further, the conditions also describe 
the installation precautions. Make sure to read them before use.

Installation Conditions
Consider the following environmental conditions 
before selecting the device installation location.

�� Installation Environment
Use in a location where temperature and 
humidity are within the following ranges.

Ambient 
temperature:

10ºC to 35ºC

Ambient 
humidity:

10% to 85%RH (relative humidity)

Max. wet-bulb 
temperature:

25ºC

Memo

⿟⿟ Make sure there is no condensation.

⿟⿟ If installing in a location where the ambient humidity is 
30% or less, use a humidifier or static prevention mat.

�� Installation Space
Make sure the area around the device has 
the following space, and select a location that 
can support the weight of the device before 
installing. (The main unit weights are as follows: 
C911/C931/ES9411dn/ES9431dn: Approx. 
97kg*; C941/ES9541dn: Approx. 117kg.)

*: Includes consumables such as image drums and toner 
cartridges, etc.

zz Plane view

620mm

1420mm

600mm

460mm

200mm
1770mm

zz Front view

400mm

1040mm
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zz Front view (with expansion tray mounted)

400mm

1560mm

�� Installation Precautions

WARNING

⿟⿟Do not install close to high-temperature locations 
or naked flames.
⿟⿟Do not install in locations where chemical 
reactions occur (e.g., laboratories).
⿟⿟Do not install close to combustible solutions such 
as alcohol or thinners, etc.
⿟⿟Do not install within reach of small children.
⿟⿟Do not install in an unstable location (e.g., 
unsteady tables or sloping locations, etc.)
⿟⿟Do not install in humid or dusty locations, or in 
locations in direct sunlight.
⿟⿟Do not install in environments with salt air or 
corrosive gas.
⿟⿟Do not install in locations with major vibration.
⿟⿟Do not install in locations where the device air 
holes are blocked. Use the following illustrations 
to check the air hole position.

Top

Right 

side

Front

LeftBack
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CAUTION

⿟⿟Do not install directly on shaggy rugs or carpets.
⿟⿟Do not install in locations with poor air circulation 
or ventilation such as sealed rooms, etc.
⿟⿟Make sure of ventilation if using continuously for 
long hours in a small room.
⿟⿟Install away from strong magnetic fields and 
sources of noise.
⿟⿟Install away from monitors and TVs.
⿟⿟When moving the device, hold the carrying lever 
and carrying handles.
⿟⿟The main device weight is approx. 97kg for 
models C911/C931/ES9411dn/ES9431dn and 
approx. 117kg for model C941/ES9541dn. When 
lifting or moving the device, make sure to use at 
least 4 people.
⿟⿟Make sure of the ventilation if printing large 
quantities or using the device continuously for 
long hours.

*: Includes consumables such as image drums and toner 
cartridges, etc.
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Installation Procedure
Work according to the relevant procedures and the customer installation conditions. If not mounting 
any options, skip the reading of the procedures described as "Optional".

1 Opening the Package and Installation

2 Mounting Consumables (P.46)

3 Mounting the Expansion Tray (Optional) (P.50) (Optional)

4 Mounting the Built-in HDD (Optional) (P.54) (Optional)

5 Connecting Using LAN Cable (P.63)

6 Connecting Using USB Cable (P.64)

7
Installing and Connecting the Color Management Server 
("Server Installation Guide")
*: Not applicable to C911/ES9411dn.

(Sold 
separately)

8 Connecting the Power Cable and Ground Wire (P.57)

9 Connecting to the PC (P.61)

10 Adding Options (P.82) (Optional)

11 Printing from Trays (P.94)
Printing from the Multi-Purpose Tray (P.101)

Opening the Package and 
Installation

This section explains the procedure from opening 
the package to removing and installing the 
product.

Opening the Package and Moving 
the Device

Make sure to install in a sufficiently robust 
location that can support the weight of the 
device and its options. Do not install in unstable 
locations such as on unsteady tables or slanted 
locations, or in locations with strong vibrations. 
Doing so risks causing injury due to the device 
falling or toppling.

Memo

⿟⿟ For device installation locations, see “Installation 
Conditions” (P.41).

CAUTION There is a risk of injury.

⿟⿟The weight of the device is approx. 97kg for 
models C911/C931/ES9411dn/ES9431dn, and 
approx. 117kg for model C941/ES9411dn/
ES9431dn/ES9541dn, so make sure to use at 
least 4 people to lift.

*: Includes consumables such as image drums and toner 
cartridges, etc.

The main unit weights are as described below.

With the toner 
cartridge and 
image drum 

mounted

With the toner 
cartridge and 
image drum 

removed
C911/
ES9411dn

Approx. 97kg Approx. 82kg
C931/
ES9431dn

C941/
ES9541dn Approx. 117kg Approx. 91kg
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1	 Open the package, and remove the 
device accessories ( ), and enclosed 
manual, protective equipment, and 
shock-absorbing material ( ).

Note

⿟⿟ The packing and protective equipment are used 
when shipping the device, so store them carefully.

2	 Remove the cover bag enclosing the 
main printer unit.

Note

⿟⿟ Do not remove the tape securing the protective 
equipment, paper feed trays, and side covers before 
transporting the device to its installation location. 
The trays and covers opening during transport may 
cause unexpected injury.

3	 Remove the three carrying levers at the 
bottom of the printer ( ), and check 
the three locations of the carrying 
handles ( ).
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4	 Hold the carrying levers while grasping 
the carrying handles, and use at least 4 
people to lift and carry simultaneously.

Note

⿟⿟ Make sure not hold anywhere other than the 
carrying handles, such as the paper feed trays or 
side covers, etc. Doing so may cause injury due to 
dropping the device.

⿟⿟ Make sure to use 4 people min. for lifting and 
carrying so there is no back pain, etc.

5	 Gently lower the device into its 
installation location.

Note

⿟⿟ Gently and carefully lower the device. There is a 
risk of crush injuries to hands, etc.

Mounting Consumables

��Setting the Toner Cartridge

1	 Remove the toner cartridge from its 
cover bag.

2	 Shake the toner cartridge both 
horizontally and vertically.

Note

⿟⿟ Do not drop the toner cartridge or tap it on the 
floor. Doing so may damage the cartridge.

3	 Open the toner replacement cover.

4	 Check the position of the slot that is labelled 
with the same text and colors, and securely 
push in the toner cartridge all the way.
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5	 Close the toner replacement cover.

��Remove the image drum stopper
Memo

⿟⿟ The image drum is set inside the device at the factory.

Reference

⿟⿟ For the methods of replacing the image drum, see 
"Troubleshooting/Daily Maintenance Manual", or the device 
help.

The stopper is mounted to the image drum in 
the device at the factory.

Make sure to use the following procedure to 
remove the stopper before use.

1	 Open the front cover.

2	 Gently raise the (blue) lever ( ), and 
remove the image drum ( ) while 
being careful not to touch the green 
cylinder with your hands.

Note

⿟⿟ Be careful not to touch or scratch the image drum 
(green cylinder).
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3	 Place the image drum that has been 
removed on a flat surface covered with 
paper, etc., and then orient the (orange) 
stopper in the direction of the arrows (  

) to remove ( ).

4	 Align the (red) arrow labels on the 
image drum with the arrows on the 
device, and gently insert into the slot 
and push in firmly all the way while 
being careful not to touch the green 
cylinder with your hands.

Note

⿟⿟ Be careful not to touch or scratch the image drum 
(green cylinder).

5	 Close the slot cover.

Reference

⿟⿟ Model C941/ES9541dn requires the Spot Color kit to be set. 
For details, see the "Separate Volume  Spot Color Guide".
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Setting Paper

This section explains how to set the paper in tray 
1 or trays 2/3/4/5.

Memo

⿟⿟ In this section, setting paper in tray 1 is used as an 
example. Set trays 2 to 5 using the same procedure.

1	 Pull out the tray 1 paper cassette ( ).

2	 Slide the paper guide ( ) and paper 
stopper ( ) to align to the size of the 
paper that has been set.

3	 Thoroughly sort the paper. Carefully 
align the edges of the paper 
horizontally.

4	 Set the paper with the print surface 
face-down.

Note

⿟⿟ Do not exceed the " " symbol ( ) on the paper 
guide when setting the paper.

Memo

⿟⿟ Set so there is no gap between the paper guide or 
paper stopper and the paper.

5	 Use the paper guide to secure the 
paper.

6	 Return the paper cassette to the tray.
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Mounting the Expansion 
Unit (Optional)

Mount the (optional) expansion tray unit to 
increase the quantity and types of paper that 
can be set in the device.

The expansion tray unit has a large-capacity tray 
comprising the 1st and 3rd trays.

The device can expand to a maximum of 4 trays 
(5 including the standard tray).

The expansion trays can be mounted to either 
the main printer unit or the expansion tray unit.

Note

⿟⿟ If placed on a table, the expansion tray unit can be 
expanded to 2 trays (3 including the standard tray).

⿟⿟ If placed on a table, the large-capacity expansion tray unit 
cannot be used.

��Expansion tray unit  
(model: TRY-C3G1)

��Expansion tray unit with casters 
(model: TRY-C3G2)

��Mounting the expansion tray unit with 
casters to the main printer unit
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�� Large-capacity expansion tray unit 
(model: TRY-C3G3)

Memo

⿟⿟ The expanded trays are called tray 2, tray 3, tray 4, and 
tray 5.

Tray 1 (standard)
Tray 2
Tray 3
Tray 4
Tray 5

Expansion 
tray unit

Large-capacity 
expansion tray 

unit

1	 Remove the expansion tray unit from 
the package, and remove the buffering 
and protective materials.

2	 Mount the main printer unit to the 
expansion tray unit.

Gently lift the main unit using 4 people 
min., and align the holes on the base 
( ) to the 2 protrusions ( ) on the 
expansion tray unit.

Gently place on the other while 
matching the main unit to the position 
of the vertical lines on the back of the 
expansion tray unit.

CAUTION There is a risk of injury.

⿟⿟The weight of the device is approx. 97kg for 
models C911/C931/ES9411dn/ES9431dn, and 
approx. 117kg for model C941/ES9541dn, so 
make sure to use at least 4 people to lift.

*: Includes consumables such as image drums and toner 
cartridges, etc.

Note

⿟⿟ If the device is connected to a power supply, turn OFF the 
device power, and remove the cables. For how to turn OFF 
the power supply, see “Turning OFF the Power Supply” 
(P.58).
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Note

⿟⿟ If using the expansion tray unit and large-capacity 
expansion tray unit, first mount the expansion tray 
unit to the large-capacity expansion tray unit, and 
then mount the main printer unit to the expansion tray 
unit.

Printer 
base hole

Protrusion

Protrusion

⿟⿟ For the expansion tray unit and large-capacity expansion 

tray unit with casters, adjust the caster locks (x2) and feet 
(x2).

3	 Push down the lock levers on the 
casters (x2) at the front of the device 
to lock the casters.

4	 Loosen the nuts (x2) at the top of the 
feet on the right of the device.
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5	 Rotate the nuts and bolts at the bottom 
of each foot to lower the feet.

 

6	 When each foot has reached the 
ground, tighten the nuts at the top to 
secure the tray unit.

Note

⿟⿟ When moving the device, rotate and thoroughly lift the 
screws on the feet of the large-capacity expansion tray 
unit, and move while remote from the ground.

Memo

⿟⿟ If mounting the expansion tray unit, it is necessary to implement 
“Connecting Cables” (P.63) and “Connecting Power 
Cables” (P.57) before making the settings for the printer 
drivers to detect the expansion tray unit.  
See “Adding Options” (P.82).

If moving the printer or replacing consumables 
or maintenance units, or setting paper in the 
tray, check the following points to prevent the 
printer from toppling.

zz Do not press the front cover when the printer 
font cover is open.

zz Do not press on the cassette from above when 
the cassette is pulled out.
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Mounting the Built-in HDD 
(Optional)

Mount the (optional) built-in HDD to increase the 
memory capacity or implement secure printing.

Reference

⿟⿟ For the functions required by the HDD, see "Advanced".

��Built-in HDD (model: HDD-C3G)

1	 Turn OFF the device power supply, and 
remove the cables.

Note

⿟⿟ When turning OFF the power supply, make sure 
to press the power switch and wait for shutdown 
before turning OFF (O) the main power switch.

Reference

⿟⿟ “Connecting Power Cables” (P.57)

⿟⿟ “Turning OFF the Power Supply” (P.58)

2	 Loosen the screws on the access cover 
at the back of the printer ( ), and 
open the door ( ).

3	 Check that the internal LED lamp ( ) is 
OFF.

4	 Align the screws (x2) on the built-in 
HDD to the holes on the device.

5	 Rotate the screws (x2) in the direction 
of the arrows to tighten securely.

6	 Connect the HDD connectors to the 
device.
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7	 Close the access cover.

8	 Tighten the access cover screws.

  

9	 Connect the cables, and turn ON the 
device power supply.

10	Check that the standby screen is 
displayed in the liquid crystal panel.

11	Print the "Configuration".

Press either the scroll button  or  
on the control panel to display the 
"Functions" screen.

Memo

⿟⿟ Print the "Configuration" on A4 size paper. Set A4 
size paper in the paper feed tray.

12	Press the scroll button  to select [Print 
Information], and then press the [OK] 
button.

13	When the [Configuration] have been 
selected, press the [OK] button.

14	When [Execute] has been selected, 
press the [OK] button.

15	Check that the HDD has been added to 
the "Configuration".

Reference

⿟⿟ “Printer Information” (P.60)
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⿟⿟Turning ON/OFF the Power

Power Supply Precautions

WARNING
There is a risk of getting 
an electric shock and/or 

causing fire.
zz Be sure to cut off the power supply when 
attaching or removing the power supply plug 
or the earth wire.

zz Be sure to connect an earth wire to the 
grounding terminal of exclusive use.

zz Please do not connect with the ground of a 
water pipe, a gas pipe, and a telephone wire, 
or lightning rod without fail.

zz Make sure to connect with the ground terminal 
before connecting the power cord to the 
power supply plug.

zz Be sure to perform extraction and insertion of 
the power cord with a power supply plug.

zz Insert the power supply plug into the wall 
socket securely.

zz Do not touch the power cord, or machine, if 
your hands are wet.

zz Install the power cord in a location where it will 
not be stepped on, and do not place objects on 
the power cord.

zz Do not twist, bind, or knot the power cord.
zz Please do not use a damaged power cord.
zz Do not carry out foot wiring.
zz Do not connect this machine and other electric 
products to the same wall socket. If connected 
simultaneously with an air-conditioner, a copy 
machine, shredder, etc., electric noise may 
interfere with operation. When the connection 
with the same wall socket is unavoidable, 
please use a commercial noise filter or a 
commercial noise cut transformer.

zz Use the attached power cord and insert it 
directory with the ground terminal. Do not use 
power cords intended for other products with 
this machine.

zz Do not use an extension cord. When use is 
unavoidable, use a cord rated higher than 15A.

zz Use of an extended cord may cause AC 
voltage decrease and interfere with normal 
operation.

zz During printing, do not shut off the power 
supply or pull out the power supply plug.

zz When not in use for consecutive holidays or 
longterm travel, pull out the power cord.

zz Do not use the attached power cord for other 
products.

Power Supply Conditions

Observe the following power supply conditions.

Current: 110 - 127VAC
(Range 99 - 140 VAC)
220 - 240VAC
(Range 198 - 264VAC)

Power 
frequency:

50/60 Hz ± 2%

Note

⿟⿟ If the power supply is unstable, use a voltage regulator.

⿟⿟ The maximum power consumption of the device is 1500W. 
Check that there is sufficient voltage capacity.

⿟⿟ Operations cannot be assured if using an uninterruptible 
power supply (UPS) or inverter. Do not use an 
uninterruptible power supply or inverter.
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Connecting Power Cables

1	 Check that the device power supply is 
turned OFF.

The device is OFF when the main power 
switch is in the (O) position.

2	 Secure insert the enclosed power cable 
into the device power connector.

Power cable

3	 Insert the power plug into the power 
outlet.

Turning ON the Power 
Supply

Note

⿟⿟ For the C941/ES9541dn model, do not turn ON the power 
supply before the Spot Color kit has been set.

1	 Turn ON (I) the main power switch.

ON

2	 Press and hold the power switch for 
approx. 1s.

When the power supply is ON, the LED 
lamp for the power switch will turn ON.

Memo

⿟⿟ The "OKI" logo screen will be displayed in the liquid crystal 
display of the control panel when the device starts. Wait 
a moment until the standby screen is displayed, and the 
printing is enabled.

⿟⿟ When the power supply is turned ON for the first time, the 
device auto initialization will start. Wait until the standby 
screen is displayed in the liquid crystal display on the 
control panel.
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Turning OFF the Power 
Supply

During normal use, use the following procedure 
to turn OFF the power supply.

Note

⿟⿟ Once shutdown has been implemented, it cannot be 
stopped. To turn ON the device power supply again, wait 
until shutdown has finished, and then turn ON the power 
supply.

1	 Press and hold the power switch for 
approx. 1s.

"Shutting down. Please wait. Power 
will turn OFF automatically" will be 
displayed in the control panel, and the 
power switch LED lamp will flash on an 
approx. 1-s cycle.

Wait a moment, and the power 
supply for the device will turn OFF 
automatically, and the LED lamp on the 
power switch will turn OFF.

Note

⿟⿟ Press and hold the power switch for 5s min. to force-turn 
OFF the power supply. Use only if a problem has occurred.  
For device problems, see "Troubleshooting/Daily 
Maintenance Manual".

In the following cases, use the following 
procedure to turn OFF the main power supply.

If not using the device for long periods over 
holidays or during travel, etc.  
If mounting optional or maintenance products.  
If moving the device.  
If implementing device repairs or inspections, 
etc.

1	 Press and hold the power switch for 
approx. 1s.

"Shutting down. Please wait. Power 
will turn OFF automatically" will be 
displayed in the control panel, and the 
power switch LED lamp will flash on an 
approx. 1-s cycle.

Wait a moment, and the device power 
supply will turn OFF automatically, and 
the LED lamp on the power switch will 
turn OFF.

2	 Turn OFF (O) the main power switch to 
turn OFF the power supply.
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⿟⿟Test Printing Using the Printer Only
Check that printing is actually enabled using the printer only. Check by printing the device setup and 
setup details, which enable the status to be checked. (Printer information.)

Memo

⿟⿟ Print the "printer information" on A4 size paper. Set A4 size paper in the paper feed tray.

Reference

⿟⿟ See “Turning ON the Power Supply” (P.57) for how to turn ON the power supply.

1	 Set A4 paper in tray 1.

2	 Check that the standby screen is 
displayed in the liquid crystal panel.

3	 Press the [Fn] key.

The numerical value input screen will be 
displayed.

4	 Press [1], [0], [0], and then press the 
[OK] button.

5	 When [Execute] has been selected, 
press the [OK] button.

The printer information will be 
displayed.
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Printer Information
During test printing, the following device setup 
details (printer information) will be printed.

Memo

⿟⿟ Use the printer information to check the functions that 
are currently usable, the settings table, the software and 
hardware versions built into the device, and the print 
quantity, etc.

Note

⿟⿟ The printer information described here is a sample. The 
printer information printed by your device may differ in 
places.

Check here if an option 
(expansion tray unit or 
built-in HDD) is  
mounted.

Reference

⿟⿟ You can also print function reports and demo pages, etc. 
For details, see "Advanced".
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⿟⿟Connecting the PC
This section explains how to connect the device to a PC, and how to install the printer drivers from the 
enclosed "Software DVD-ROM". Prepare a PC connected to a DVD drive.

Flow for Installing Drivers on a PC

Connecting to PC
For Windows For Macintosh

Connecting via a 
network Connecting via USB

Connecting via a network
Connecting via USBConnecting via 

EtherTalk
Connecting via 

Bonjour/Rendezvous

Connecting the cables

Turning ON the device 
power supply Turning ON the device power supply

Setting the IP address 
in the device

Enabling the device 
EtherTalk

Connecting the cables Disabling device sleep 
mode

Turning ON the PC power supply

Setting the IP 
address, etc., in the 

PC

Setting EtherTalk in 
the PC

Installing the printer drivers

Turning ON the device 
power supply Adding devices to the PC

Checking operations from the PC
(See “3.Printing”)
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Operating Environment
The device is compatible with the following operating systems (OS).

zz Windows 8/Windows 8 (64-bit version)*1

zz Windows Server 2012

zz Windows 7/Windows 7 (64-bit version)

zz Windows Vista/Windows Vista (64-bit version)

zz Windows Server 2008 R2

zz Windows Server 2008/Windows Server 2008 (x64 version)

zz Windows XP/Windows XP (x64 version)

zz Windows Server 2003/Windows Server 2003 (x64 version)

zz Mac OS X 10.3.9 to OS X 10.8

zz Mac OS 9.1 to 9.2.2*2

*1: 	For Windows 8, only desktop mode is compatible.

*2: 	Download and use the Mac OS 9 printer drivers from the OKI homepage. (http://www.okidata.co.jp/)

Printer Driver Types
The following types of printer driver can be installed.

zz Windows

Type Explanation
PS Applies to the printing of documents that include PostScript fonts and EPS 

data.

PCL*1 Applies to the printing of business documents.

XPS*2 Applies to printing from applications that support XPS.

*1:  	 Windows XP requires that Internet Explorer 6.0 or later (MSXML 4.0 or later) be installed.

*2:  	 Windows XP/Windows Server 2003 are not compatible.

zz Mac OS/Mac OS X

Type Explanation
PS Applies to the printing of documents including PostScript fonts and EPS data.

Can also be used for regular printing.

Note

⿟⿟ Descriptions may differ depending on the printer driver, and Windows or Mac OS version.

http://www.okidata.co.jp/
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Connecting Cables
Connect the device to a PC or network.

The device is equipped with the LAN (network) 
interface connectors and USB interface 
connectors as standard. Connections can be 
made to the network directly using LAN cables, 
and to the PC using USB cables.

Connecting Using LAN Cables

Connecting the device to a network such as 
LAN (Ethernet*), etc., enables the device to 
be shared by all the PCs on the network. This 
system can be used by OS such as Windows or 
Mac, etc.

*: The device is equipped with network interfaces compatible 
with 10BASE-T/100BASE -TX/1000BASE-T as standard.

Windows

Windows

Macintosh

Macintosh

Hub

��  Preparations

LAN cable Hub

Note

⿟⿟ LAN cables and hubs are not enclosed with the device. 
Prepare LAN cables (category 5 or greater, twist pair 
cable, straight) and hubs as necessary.

⿟⿟ The setup must be changes if using with 1000BASE-T 
as the factory default settings are "Gigabit network: 
Disabled" in the administrator setup menu.  
Setup method: In the control panel, select [Admin 
Setup]> Enter the password> [Network Setup]> [Gigabit 
network]> [Enable].

��Connecting LAN Cables

1	 Connect the LAN cable to the LAN 
(network) interface connector ( ).

Connect the other end of the LAN cable 
to the hub connector ( ).

LAN (network)  
interface

Connector

LAN cable
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Connecting Using USB Cables

Connect the device and PC using USB cables.

USB cable

��Preparations

USB cable

Note

⿟⿟ USB cables are not enclosed with the device. Prepare 
USB cables with USB2.0 specifications, length 2m min. as 
necessary.

⿟⿟ If connecting using USB2.0 Hi-Speed mode, use a USB 
cable with Hi-Speed USB2.0 specifications.

��Connecting USB Cables
Note

⿟⿟ If the printer drivers are not installed on the PC, remove 
the USB cable fromthe PC, and first install the printer 
drivers. (page 72)

1	 Pay attention to the connector 
orientation, and connect the square end 
of the USB cable to the Printer ( ). 
Connect the other, flat end to the PC ( ).

USB cable

USB interface  
connector

USB port

Note

⿟⿟ Be careful not to insert the USB cable into the LAN 
(network) interface connector. Doing so may cause a 
printer malfunction.

⿟⿟ Do not insert the USB cable when the PC or device power 
supply is ON. Doing so may cause a printer malfunction.

Memo

⿟⿟ Set the device USB baud rate using the control panel 
according to the USB port baud rate (speed) mounted 
to the PC. For the control panel, see “Control Panel 
Appearance” (P.32).
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Installer Printer Drivers 
(Windows)

Network Connections

To connect the Windows PC and device to the 
network, first set the device IP address. Next, 
install the printer drivers on the PC.

If there are no DHCP or BOOTP servers on the 
network, it is necessary to set the IP address on 
the PC and device manually.

Further, it is also necessary to set the IP address 
in the PC and device manually if instructed to 
set a specific IP address determined by the in-
house network administrator, provider, or router 
manufacturer.

��Setup Flow
Turning ON the device power supply

Setting the IP address in the device

Turning ON the PC power supply

Setting the IP address, etc., in the PC

Installing the printer drivers

Note

⿟⿟ If the IP address is incorrect, the network may go 
down, or internet connections be disabled. Check the IP 
addresses that can be set in the device with your in-house 
network administrator or internet service provider.

⿟⿟ The server on the network (DHCP, etc.) depends on the 
network environment in use. Check with your in-house 
network administrator, internet service provider, or router 
manufacturer.

⿟⿟ Setup requires computer administrator privileges.

⿟⿟ In "Setting Up", the operating procedure described is for 
Windows 7 unless otherwise specified. The screens and 
operating procedure may differ depending on the OS.

��Setting the IP Address in the 
Device Using the Control Panel

Memo

⿟⿟ If configuring using a small network that connects 
the device to a single PC, set the following IP address 
(conforming to RFC1918).

⿟⿟ PC

-- IP address: Any from 192.168.0.1 to 254

-- Subnet mask: 255.255.255.0

-- Default gateway: Not used

-- DNS server: Not used

⿟⿟ Device

-- IP address setup: Manual from 192.168.0.1 to 254 
(Select a different value fom the PC.)

-- Subnet mask: 255.255.255.0

-- Default gateway: 0.0.0.0

-- Network size: Small

This section explains the following settings as an 
example.
IP address: 	 192.168.0.3 (PC)
		  192.168.0.2 (Device)
Subnet mask: 	 255.255.255.0
Gateway address: 	 192.168.0.1

1	 Press either the scroll button  or  
on the control panel to display the 
"Functions" screen.

2	 Press the scroll button  several times 
to select [Admin Setup], and then press 
the [OK] button.
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3	 Use the 10-key pad to enter the 
administrator password.

The default factory-set password is 
"aaaaaa". Press the [OK] button after 
entering each individual character.

4	 Press the [OK] button.

5	 Check that [Network Setup] has been 
selected, and press the [OK] button.

1
2
3
4
5
6

Admin Setup 1/2 Page

Network Setup

Print Setup

PS Setup

PCL Setup

XPS Setup

Use Online button to return to standby screen

USB Setup

6	 Press the scroll button  several times 
to select [IP Address Set], and then 
press the [OK] button.

1
2
3
4
5
6

Network Setup 1/2 Page

TCP/IP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby screen

NetBIOS over TCP

7	 If setting the IP address manually, press 
the scroll button  to select [Manual], 
and then press the [OK] button.

Go to Step 8

1
2
3
4
5
6

TCP/IP

NetBIOS over TCP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby scr

Network Setup

Use Online button to return 

2 Manual

Auto1
1/1 PageIP Address Set

If acquiring the IP address automatically, 
check that [Auto] has been selected, and 
then press the [OK] button.

Go to Step 14

1
2
3
4
5
6

TCP/IP

NetBIOS over TCP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby scr

Network Setup

Use Online button to return 

2 Manual

Auto1
1/1 PageIP Address Set

8	 Press the scroll button  several times 
to select [IPv4 Address], and then click 
the [OK] button.

1
2
3
4
5
6

Network Setup 1/2 Page

TCP/IP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby screen

NetBIOS over TCP

9	 Use either the scroll buttons  or the 
10-key pad to enter the first 3 digits 
of the IP address, and then press the 
[OK] button. Enter the next 3 digits 
in the same way. When all entries are 
complete, press the [BACK] button.

To move to the next box, press the [OK] 
button.

1
2
3
4
5
6

TCP/IP

NetBIOS over TCP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby sc

Network Setup

Use Online button to return 

xxx.xxx.xxx.xxx

IPv4 Address
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10	Press the scroll button  to select 
[Subnet Mask], and then press the [OK] 
button.

1
2
3
4
5
6

Network Setup 1/2 Page

TCP/IP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby screen

NetBIOS over TCP

11	Enter the subnet mask in the same way 
as the IP address. When all entries are 
complete, press the [BACK] button.

6 Subnet Mask

Use Online button to return to standby screen

Network Setup

Use Online button to return 

xxx.xxx.xxx.xxx

Subnet Mask

12	Press the scroll button  to select 
[Gateway Address], and then press the 
[OK] button.

1
Network Setup 2/2 Page

Gateway Address

Use Online button to return to standby screen

13	Enter the gateway address in the same 
way as the IP address. When all entries 
are complete, press the [BACK] button.

1 Gateway Address

Use Online button to return to standby screen

Network Setup

Use Online button to return 

xxx.xxx.xxx.xxx

Gateway Address

14	Press the [ON LINE] button to complete 
the network setup.
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��Setting the IP Address in the PC
Note

⿟⿟ If the IP address has already been set in the PC or is 
acquired automatically, go to “Installing Printer Drivers” 
(P.70).

1	 Turn ON the PC power supply to start 
Windows.

2	 Click [Start], and select [Control panel].

3	 Click [View network status and tasks].

4	 Click [Local Area Connection], and then 
click [Properties] in the "Local Area 
Connection Status" window.

5	 Select [Internet Protocol Version 4 (TCP/
IPv4)], and click [Properties].

6	 Enter the IP address, Subnet mask, 
Default gateway, and DNS server, and 
click [OK].

Memo

⿟⿟ If acquiring the IP address from the DHCP server 
automatically, select "Obtain an IP address 
automatically", and do not enter an IP address.

⿟⿟ Do not enter if not using a Default gateway or DNS 
server.

7	 Close the "Local Area Connection 
Properties" window.
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��Setting the Device Network

1	 Check that the device and PC are 
connected, and that the power is turned 
ON, and then insert the "Software DVD-
ROM" into the PC.

2	 When the "AutoPlay" window is 
displayed, click [Run Setup.exe].

3	 When the "User Account Control" 
window is displayed, click [Yes].

4	 Read the "Software License Agreement" 
thoroughly, and click [Agree].

5	 Read the "Environmental advice for 
Users", and click [Next].

6	 Set the printer model to be set, and 
click [Next].

7	 Select [Network connection], and click 
[Next].

8	 Click [Device Network Setup].

9	 The printer search will start. Select the 
device from the table when the printer 
has been detected, and click [Next].

10	Enter the network setup information, 
and click [Setup].

11	Enter the network setup password, and 
click [OK].
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12	When the setup is complete, the device 
will restart automatically, and the 
display will return to the menu selection 
screen.

Click [Exit] in the menu screen to finish.

�� Installing Printer Drivers

1	 Check that the device and PC are 
connected, and that the power supply is 
turned ON.

Reference

⿟⿟ “Connecting Using LAN Cables” (P.63)

2	 Insert the "Software DVD-ROM" into the 
PC.

3	 When the "AutoPlay" window is 
displayed, click [Run Setup.exe].

4	 When the "User Account Control" 
window is displayed, click [Yes].

5	 Read the "Software License Agreement", 
and click [Agree].

6	 Read the "Environmental advice for 
Users", and click [Next].

7	 Select the printer model to be used, 
and click [Next].

8	 Select [Network connection], and click 
[Next].



- 71 -

Connecting the PC

A
p
p
en

d
ix

Prin
tin

g

3

S
ettin

g
 U

p

2

B
efo

re u
se

1

Basic D
evice O

perations

4

In
d
ex

9	 Click [Recommended Install].

Memo

⿟⿟ Click [Custom install] to select "PCL6 Driver" and 
"XPS Driver".

10	The printer search will start. When the 
printer has been detected, select the 
device from the table. Click [Next] to 
start the installation.

11	When the installation is complete, click 
[Exit].

12	Click [Exit] in the menu screen to finish.

13	Select [Start]> [Devices and Printers].

14	Check that the OKI C931 icon is 
displayed.

Right-click the OKI C931 icon and select 
and item from the menu, and check 
that all the printer drivers that have 
been installed are displayed in the sub-
menu.

15	Remove the "Software DVD-ROM" from 
the PC.

Reference

⿟⿟ For how to print from the PC, see “Printing from Trays” 
(P.94).
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USB Connections

Note

⿟⿟ Check that the device power supply is turned OFF.

⿟⿟ Setup requires computer administrator privileges.

⿟⿟ This section described the operating procedure for 
Windows 7 unless otherwise specified. The screens and 
operating procedure may differ depending on the OS.

��Setup Flow
Turning ON the PC power supply

Installing the printer drivers

Turning ON the device power supply

1	 Turn ON the PC power supply to start 
Windows.

Memo

⿟⿟ When the device power supply is turned ON, the 
"Add new software wizard" may be displayed in the 
screen. If this happens, click "CANCEL", and then 
turn OFF the device beore proceeding to the next 
step.

2	 Insert the "Software DVD-ROM" into the 
PC.

3	 When the "AutoPlay" window is 
displayed, click [Run Setup.exe].

4	 When the "User Account Control" 
window is displayed, click [Yes].

5	 Read the "Software License Agreement", 
and click "Agree".

6	 Read the "Environmental advice for 
Users", and click [Next].

7	 Select the printer model to be used, 
and click [Next].

8	 Select "USB connection", and click 
[Next].
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9	 Click [Recommended Install] to start 
the installation.

Memo

⿟⿟ Click [Custom install] to select "PCL6 Driver" and 
"XPS Driver".

10	When the following screen is displayed 
during the installation, connect the 
device and PC using a USB cable, and 
then turn ON the device power supply.

Memo

⿟⿟ If the display does not change even when the device 
is connected, click "Install using another port".  
Select the port to which the device is connected 
using the "Printer port" screen, and click [Next].

11	When the installation is complete, click 
[Exit].

12	In the menu screen, click [Exit]> [Yes].

13	Select [Start]> [Devices and Printers].
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14	Check that the OKI C931 icon is 
displayed.

Right-click the OKI C931 icon and select 
and item from the menu, and check 
that all the printer drivers that have 
been installed are displayed in the sub-
menu.

15	Remove the "Software DVD-ROM" from 
the PC.

Reference

⿟⿟ For how to print from the PC, see “Printing from Trays” 
(P.94).

If Setup Fails

If setup fails using either a network or USB 
connection, see the enclosed "Troubleshooting/
Daily Maintenance Manual".

This manual explains the possible causes of the 
setup trouble and the countermeasures.

Installing Printer Drivers 
(Macintosh)

Network Connections

To connect Mac OS X and the device via a 
network, install the printer drivers on the 
computer, and then set the device as a network 
printer.

��Deciding the Print Method 
(Protocol)

There are two printing methods from Mac OS X: 
Using EtherTalk, and using Bonjour/Rendezvous.

Print method
(Protocol) Features

EtherTalk Uses functions mounted 
as standard to OS X 
10.3 to 10.5, and Mac 
OS 9.1 to 9.2.2.

Bonjour
(Bonjour)
Rendezvous
(Rendezvous)

Use this with TCP/IP 
networks.
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��Setup Flow
The setup procedure may differ depending on 
the print method.

EtherTalk Bonjour/
Rendezvous

Turning ON the power 
supply

Turning ON the power 
supply

Enabling the device 
EtherTalk

Disabling device sleep 
mode

Turning ON the PC power 
supply

Turning ON the PC power 
supply

Setting EtherTalk in the 
PC

Installing the printer 
drivers

Installing the printer 
drivers

Adding devices to the PC Adding devices to the PC

Go to “Using EtherTalk”. Go to “Using Bonjour 
(Rendezvous)” (P.78).

Note

⿟⿟ Upgrading the Mac OS X or printer driver version may 
result in differences from the description in the manual.

⿟⿟ Disable all anti-virus software before starting the setup.

��Using EtherTalk

��Enable EtherTalk using the control panel, 
and disable sleep mode

If connecting to a network using EtherTalk, it 
is necessary to enable EtherTalk in the printer, 
and disable sleep mode. Next, install the printer 
drivers in the computer.

Reference

⿟⿟ People using Bonjour go to “Using Bonjour (Rendezvous)” 
(P.78).

1	 Press either the scroll button  or  
on the control panel to display the 
"Functions" screen.

2	 Press the scroll button  several times 
to select [Admin Setup], and then press 
the [OK] button.

3	 Use the 10-key pad to enter the 
administrator password.

The default factory-set password is 
"aaaaaa". Press the [OK] button after 
entering each individual character.

4	 Press the [OK] button.
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5	 Check that [Network Setup] has been 
selected, and press the [OK] button.

1
2
3
4
5
6

Admin Setup 1/2 Page

Network Setup

Print Setup

PS Setup

PCL Setup

XPS Setup

Use Online button to return to standby screen

USB Setup

6	 Press the scroll button  several times 
to select [EtherTalk], and then click the 
[OK] button.

1
2
3
4
5
6

Network Setup 1/1 Page

TCP/IP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby screen

NetBIOS over TCP

7	 Press the scroll button  to select 
[Enable], and then press the [OK] 
button.

1
2
3
4
5
6

TCP/IP

NetBIOS over TCP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby screen

Network Setup

Use Online button to return 

2 Disable

Enable1
1/1 PageEtherTalk

8	 Press the [BACK] button to display the 
"Network Setup" screen.

1
2
3
4
5
6

Network Setup 1/2 Page

TCP/IP

EtherTalk

IP Address Set

IPv4 Address

Subnet Mask

Use Online button to return to standby screen

NetBIOS over TCP

9	 Press the [BACK] button to display the 
[Admin Setup] screen.

1
2
3
4
5
6

Admin Setup 1/2 Page

Network Setup

Print Setup

PS Setup

PCL Setup

XPS Setup

Use Online button to return to standby screen

USB Setup

10	Press the scroll button  several times 
to select [Power Setup], and then click 
the [OK] button.

11	Press the scroll button  to select 
[Sleep], and then click the [OK] button.

12	Press the scroll button  to select 
[Disable], and then click the [OK] 
button.
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13	Press the [ON LINE] button to return to 
the standby screen.

�� Installing the printer drivers on the computer

1	 Check that the device and PC are 
connected, and that the power supply is 
turned ON.

Reference

⿟⿟ “Connecting Using LAN Cables” (P.63)

2	 Insert the "Software DVD-ROM" into the 
PC.

3	 Double-click the OKI icon on the 
desktop.

4	 Double-click [Driver]> [Installer for Mac 
OS X].

5	 Enter the Mac OS X administrator 
password, and click [Install Software].

Finish the installation by following the 
instructions displayed on the screen.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Print & Scan].

8	 Click [+].

9	 Click [AppleTalk].
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10	Select the printer, and check that [OKI 
C931(PS)] is displayed in [Print Using].

11	Click [Add].

12	Check that [C931] is displayed as added 
to the printer list, and close the [Print & 
Scan] screen.

Note

⿟⿟ If [OKI C931(PS)] is not displayed correctly in 
[Kind], click [-] to delete the device from [Printers], 
and repeat Steps 7 to 10 again.

13	Remove the "Software DVD-ROM" from 
the computer.

��Using Bonjour (Rendezvous)

�� Installing the printer drivers on the 
computer

1	 Check that the device and PC are 
connected, and that the power supply is 
turned ON.

Reference

⿟⿟ “Connecting Using LAN Cables” (P.63)

2	 Insert the "Software DVD-ROM" into the 
computer.

3	 Double-click the OKI icon on the 
desktop.

4	 Double-click [Driver]> [Installer for Mac 
OS X].

5	 Enter the Mac OS X administrator 
password, and click [Install software].

Finish the installation by following the 
instructions displayed on the screen.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Print & Scan].

8	 Click [+], and select [Add printer or 
scanner].
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9	 Click [Default].

10	Select the printer displayed as 
[Bonjour] in [Kind], and check that [OKI 
C931(PS)] is displayed in [Use].

The name of the printer will be 
displayed in the format "OKI-C931-(last 
6 digits of MAC address)".

11	Click [Configure] in the next screen. 
If the optional expansion tray unit has 
been mounted to the device, you can 
change the number of trays.

If an optional built-in HDD has been 
mounted, enable the [Hard Disk] check 
box.



- 80 -

Connecting the PC

A
p
p
en

d
ix

Prin
tin

g

3

S
ettin

g
 U

p

2

B
efo

re u
se

1

Basic D
evice O

perations

4

In
d
ex

12	Check that [OKI-C931-(last 6 digits of 
MAC address)] is displayed as added to 
the printer list, and close the "Print & 
Scan" screen.

Note

⿟⿟ If [OKI C931(PS)] is not displayed correctly in 
[Kind], click [-] to delete the device from [Printer], 
and then repeat Steps 8 to 11 again.

13	Remove the "Software DVD-ROM" from 
the PC.

USB Connections

To connect Mac OS X and the device via USB, 
install the printer drivers on the computer, and 
then set the device as a USB printer.

��Setup Flow
Turning ON the power supply

Turning ON the PC power supply

Installing the printer drivers

Adding devices to the PC

Note

⿟⿟ Upgrading Mac OS X or the printer driver versions may 
cause differences from the description in the manual.

⿟⿟ Disable all anti-virus software before starting the setup.

1	 Check that the device and PC are 
connected, and that the power supply is 
turned ON.

Reference

⿟⿟ “Connecting Using USB Cables” (P.64)

2	 Insert the "Software DVD-ROM" into the 
computer.

3	 Double-click the OKI icon on the 
desktop.

4	 Double-click [Driver]> [Installer for Mac 
OS X].
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5	 Enter the Mac OS X administrator 
password, and click [Install software].

Finish the installation by following the 
instructions displayed on the screen.

6	 Select [System Preferences] from the 
Apple menu.

7	 Click [Print & Scan].

8	 Click [+].

9	 Select the printer displayed as [USB] in 
[Kind].

Check that [OKI DATA CORP C931] is 
displayed in the "Add" screen, and click 
[Add].

10	Click [Configure] in the next screen. 
If the optional expansion tray unit has 
been mounted to the device, you can 
change the number of trays.

If an optional built-in HDD has been 
mounted, enable the [Hard Disk] check 
box.

11	Check that [OKI DATA CORP C931] is 
displayed as added to the printer list, 
and close the "Print & Scan" screen.
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12	Remove the "Software DVD-ROM" from 
the PC.

Reference

⿟⿟ For how to print from the PC, see “Printing from Trays” 
(P.94).

If Setup Fails

If setup fails using either a network or USB 
connection, see the enclosed "Troubleshooting/
Daily Maintenance Manual".

This manual explains the possible causes of the 
setup trouble and the countermeasures.

Adding Options
Use the following procedure to set the printer 
drivers if an optional expansion unit or built-in 
HDD have been mounted to the device.

��Windows PS Printer Drivers

1	 Click [Start], and select [Devices and 
Printers].

2	 Right-click the OKI C931 icon, and 
select [Printer properties]. ([OKI 
C931(PS)] if installing multiple printer 
drivers.)

3	 Select the [Device Settings] tab. 

��Adding an Expansion Tray Unit

4	 If using a network connection, click 
[Get installed options automatically] in 
[Installable Options].

If using a USB connection, enter the 
number of trays minus the multi-
purpose tray in [Available Trays].

For example, if three expansion trays 
are mounted, the usable trays are trays 
1/2/3/4, so enter "4".
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��Adding the Built-in HDD

4	 If using a network connection, click 
[Get installed options automatically] in 
[Installable Options].

If using a USB connection, select 
[Installed] in [Hard Disk].

5	 Click [OK].

��Windows PCL Printer Drivers

1	 Click [Start], and select [Devices and 
Printers].

2	 Right-click the OKI C931 icon, and 
select [Printer properties]. ([OKI 
C931(PCL6)] if installing multiple 
printer drivers.)

3	 Select the [Device Options] tab. 

��Adding an Expansion Tray Unit

4	 If using a network connection, click [Get 
Printer Settings].

If using a USB connection, enter the 
number of trays minus the multi-
purpose tray in [Installed Paper Trays].

For example, if three expansion trays 
are mounted, the usable trays are trays 
1/2/3/4, so enter "4".
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��Adding the Built-in HDD

4	 If using a network connection, click [Get 
Printer Settings].

If using a USB connection, enable the 
[Printer Hard Disk] check box.

5	 Click [OK].

��Windows XPS Printer Drivers

1	 Click [Start], and select [Devices and 
Printers].

2	 Right-click the OKI C931 icon, and 
select [Printer properties]. ([OKI 
C931(XPS)] if installing multiple 
printers.)

3	 Select the [Device Options] tab. 

��Adding an Expansion Tray Unit

4	 If using a network connection, click [Get 
Printer Settings].

If using a USB connection, enter the 
number of trays minus the multi-
purpose tray in [Installed Paper Trays].

For example, if three expansion trays 
are mounted, the usable trays are trays 
1/2/3/4, so enter "4".
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��Adding the Built-in HDD

4	 If using a network connection, click [Get 
Printer Settings].

If using a USB connection, enable the 
[Printer Hard Disk] check box.

5	 Click [OK].

��Mac OS X PS Printer Drivers
Note

⿟⿟ This section describes the operations procedures for 
Mac OS X 10.8 unless otherwise specified. Screens and 
operations procedures may differ depending on the 
version.

1	 Select [System Preferences] from the 
Apple menu.

2	 Click [Print & Scan].

3	 Select the printer, and click [Options 
and Supplies].

4	 Select the [Driver] tab. 

��Adding an Expansion Tray Unit

5	 Select the correct value for [Available 
Trays], and click [OK].

��Adding the Built-in HDD

5	 Enable the [Hard Disk] check box, and 
click [OK].

6	 Click [OK].
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��Memo
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3.Printing
This chapter explains the methods from setting the paper in the device to actual printing.

zz Paper

Usable Paper Types
For high-quality printing it is necessary to use paper that satisfies conditions regarding quality, 
thickness, paper finish, etc. If printing on paper not recommended by OKI, thoroughly test the print 
quality and paper traveling performance, etc., and check that there are no impediments before use.

If using a (paper) medium that is curled or wrinkled before printing, print quality and paper traveling 
performance cannot be assured.
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�� Paper Types, Size, and Thickness
Note

zz Paper sources and output are restricted by paper type, size, and thickness.

Type Size unit: mm (inches) Thickness
Plain paper A3Nobi 328×453 GSM paper weight 52-360g/m2 (ream 

weight 45-309kg)
Paper under GSM paper weight 52 to 
64g/m2 (ream weight less than 45 to 
55kg) and GSM paper weight 320 to 
360g/m2 (ream weight 275 to 309m2) 
paper cannot be used for 2-sided 
printing.

Note

zz If the paper size settings satisfy the 
following conditions, print speed will be 
slowed.  
Paper size: A6, A5; paper width 216mm 
(letter width) max.

A3Wide  320×450

A3 297×420

A4 Wide  225×320

A4 210×297

A5 148×210

A6 105×148

B4 257×364

B5 182×257

B6 128×182

B6 Half*1 64×182

Letter 215.9×279.4 (8.5×11)

Legal (13 inch) 215.9×330.2 (8.5×13)

Legal (13.5 inch) 215.9×342.9 (8.5×13.5)

Legal (14 inch) 215.9×355.6 (8.5×14)

Executive 184.2×266.7 (7.25×10.5)

Tabloid Extra 304.8×457.2 (12×18)

Tabloid 279.4 × 431.8 (11 × 17)

Statement 139.7 × 215.9 (5.5 × 8.5)

13 × 18 inch 330.2 × 457.2

16K (184×260mm) 184×260

16K (195×270mm) 195×270

16K (197×273mm) 197×273

8K (260×368mm) 260×368

8K (270×390mm) 270×390

8K (273×394mm) 273×394

Custom*2 Width 64 to 330
Length 89 to 1321

GSM paper weight 52-360g/m2 (ream 
weight 45-309kg)
Paper with widths from 99.0 to 
330.0mm and lengths from 147 to 
483.0mm can be used for 2-sided 
printing.

Hagaki Hagaki 100×148 Japanese Postcard
These can be used for 2-sided printing.Oufuku Hagaki 148×200

4-Ren Hagaki 200 × 296

*1: 	B6 half size cannot be used for 2-sided printing.

*2:	Paper with widths from 99.0mm to 330.0mm and lengths from 147 to 483.0mm can be used for 2-sided printing.
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Type Size unit: mm (inches) Thickness
Envelopes* Younaga #3 120×235 Using GSM weight 85g/m2 paper

Kakugata #6 162 × 229

Nagagata #3 120×235

Nagagata #4 90×205

Nagagata #40 90×225

Yougata #0 120×235

Yougata #2 114×162

Yougata #4 105×235

Kakugata #6 162 × 229

Kakugata #2 240×332

Kakugata #3 216×277

Younaga #3 120 × 235

Kakugata #8 119×197

Com-9 98.4×226.1 (3.875×8.875) 24LB paper is used, with flaps firmly 
creasedCom-10 104.8×241.3 (4.125×9.5)

Monarch 98.4×190.5 (3.875×7.5)

DL 110×220 (4.33×8.66)

C5 162×229 (6.4×9)

C4 229×324 (9×12.8)

Labels A4 0.1 to 0.2mm

Letter

Glossy A4 210 × 297

A3 297 × 420

A3Nobi 328 × 453

Partially 
printed paper

Equivalent to plain paper. GSM paper weight 52-360g/m2 (ream 
weight 45-309kg)

Color paper Equivalent to plain paper. GSM paper weight 52-360g/m2 (ream 
weight 45-309kg)

Transparency A4 0.1 to 0.125mm

Letter

Index Card* Index Card 76.2×127 (3×5)

*: 2-sided printing is not possible on envelopes or index cards.
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Paper Feed and Output Methods Selectable for Each 
Paper type
	 O: Usable

	 X: Not usable

Type Size Thickness

Settable tray Output bin

Multi-purpose 
tray Tray 1

Trays 
2 to 5

(Optional)
Face-up Face-down

Plain paper
(With 
2-sided 
printing)

A3Nobi, A3Wide, A3, 
A4Wide, A4, A5, A6, 
B4, B5, B6, Letter, 
Legal13, Legal13.5, 
Legal14, Executive, 
Tabloid Extra, 
Tabloid, Statement, 
16K (184x260mm), 
16K (195x270mm), 
16K (197x273mm), 
8K (260x368mm), 
8K (270x390mm), 
8K (273x394mm), 
13"×18"

GSM 64 to 320 g/m2

O O O O O

Custom (Width 90 to 
330mm, length 147 
to 457mm)

GSM 64 to 320 g/m2

O O O O O

Custom (Width 64mm 
min., less than 90mm; 
length greater than 
457mm to 483mm 
max.)

GSM 64 to 320 g/m2

O X X O X

Plain paper
(With 
1-sided 
printing)

A3Nobi, A3Wide, A3, 
A4, A5, A6, B4, B5, 
B6, B6 Half, Letter, 
Legal13, Legal13.5, 
Legal14, Executive

GSM 52 to 320 g/m2

O O O O O

Tabloid Extra, 
Tabloid, Statement, 
16K (184x260mm), 
16K (195x270mm), 
16K (197x273mm), 
8K (260x368mm), 
8K (270x390mm), 
8K (273x394mm), 
13"×18"*1

GSM larger than 320 
up to 360g/m2 max.

O X X O X

Custom
(Width 90 to 330mm, 
length 147 to 457mm)

GSM 52 to 320 g/m2

O O O O O

Custom (Width 64mm 
min., less than 90mm; 
length greater than 
483mm to 1321mm 
max.)

GSM 52 to 320 g/m2

O X X O X

Custom
(Width 64 to 330mm, 
length 89 to 1321mm)

GSM larger than 320 
up to 360g/m2 max. O X X O X
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Type Size Thickness

Settable tray Output bin

Multi-purpose 
tray Tray 1

Trays 
2 to 5

(Optional)
Face-up Face-down

Postcard*2 Hagaki, Oufuku 
Hagaki 
4-Ren Hagaki*1

-
O O O O O

Envelope*2 Nagagata #3, 
Nagagata #4, 
Nagagata #40, 
Yougata #0, Yougata 
#2 (C6), Yougata 
#4, Kakugata #2, 
Kakugata #3, 
Kakugata #6*1, 
Kakugata #8, Younaga 
#3*1

Using GSM weight 
85g/m2 paper

O X X O X

Com-9, Com-10, 
Monarch, DL, C5, C4

Uses 24Lb paper O X X O X

Labels*2 A4, Letter - O O X O X
Glossy*2 A4, A3, A3Nobi GSM 128g/m2 (ream 

paper 110kg) O O O O O

Transparency*2 A4, Letter - O O X O X
Index cards 76.2mm×127mm 

(3"×5") O X X O X

*1: Use the printer control panel to set the paper size of the tray used to [Custom], and set [Paper width] and [paper length] to 
the values shown in the table below. Use the printer drivers to select the values from the table below.

Paper Size
Device Setup Setting the printer 

driver [Paper size]Paper width (mm) Paper length (mm)
13"×18" 330 475 13 × 18in

4-Ren Hagaki 200 296 4-Ren Hagaki

Kakugata #6 162 229 Kakugata #6

Younaga #3 120 235 Younaga #3

*2: 	Print speed is slower for postcards, envelopes, labels, glossy paper, and transparencies.

Note

zz If setting paper in the tray horizontally ( ), print speed will be slower than if set vertically ( ).

zz Printing will be slower if the paper size set is A6 or A5 size, or has a smaller width than 148mm (A5 width).
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(Landscape) and 
(Portrait) Icons
 icon describes placing the paper vertically as 

viewed from the front of the printer. (Paper is fed 
horizontally.)

Trays

Multi-Purpose Tray

Paper Feed 
Orientation

Paper Feed Orientation

 icon describes placing the paper horizontally 
as viewed from the front of the printer. (Paper is 
fed vertically.)

Trays

Multi-Purpose Tray

Paper Feed 
Orientation

Paper Feed Orientation

Paper of the following sizes can be set either 
horizontally or vertically.

zz The three types of A5, B5, and 16K, and A4 
wide
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zz Printing from Trays
With the exception of some paper sizes, the printer automatically detects the size of paper set in trays 
1 to 5*. Further, only the width of the paper size is automatically detected.

*: Trays 2 to 5 are optional.

Memo

zz The printer does not automatically detect the following paper sizes.  
- A3NOBI, tabloid extra, A3WIDE, 13×18" 
-A5, A6 
-postcards, Japanese double postcards 
-legal13.5, legal14 
-custom

If the printer does not detect automatically, use the control panel to set the paper size. For details, see “Setting Paper Using 
the Control Panel” (P.98).

zz Set 13x18" as custom size.

Setting Paper in Trays 1 to 5
This section explains how to set paper in tray 1 
or trays 2/3/4/5.

Memo

zz Setting paper in tray 1 is used here as an example. Set 
trays 2 to 5 using the same procedure.

1	 Pull out the tray 1 paper cassette ( ).

2	 Slide the paper guide ( ) and paper 
stopper ( ) to align to the size of the 
paper that has been set.

3	 Thoroughly sort the paper. Carefully 
align the ends of the paper horizontally.
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4	 Set the paper with the print surface 
face-down.

Note

zz Do not exceed the " " symbol ( ) on the paper 
guide when setting the paper.

Memo

zz Set so there is no gap between the paper and the 
paper guide or paper stopper.

5	 Use the paper guide to secure the 
paper.

6	 Return the paper cassette to the tray.

Printing from Trays
Open the file to be printed on the PC, and 
select [Paper Size], [Paper Source], and [Media 
Weight] to print via the paper driver.

This section explains how to print using "Tray 1" 
or "Auto" from the following printer drivers.

zz Windows PS printer driver

zz Windows PCL printer driver (P.95)

zz Windows XPS printer driver (P.96)

zz Mac OS X printer driver (P.97)
Further, this explanation uses "WordPad" for 
Windows as the application used. For Mac OS X, 
the example uses "TextEdit".

Reference

zz For how to install the printer drivers, see “Connecting the 
PC” (P.61).

zz For how to print from the multi-purpose tray, see “Printing 
from the Multi-Purpose Tray” (P.98).

Memo

zz Select [Auto] in [Paper Source] to automatically select the 
tray holding the designated paper.

��Using Windows PS Printer Drivers

1	 Open the file to be printed using 
WordPad.

2	 Click [Page Setup] in the [File] menu.

3	 Select the paper size and print 
orientation, and click [OK].

4	 Click [Print] in the [File] menu.

5	 Click [Advanced] (or [Properties]).
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6	 Use [Paper Source] in the [Paper/
Quality] tab to select the tray to be 
used, and click [Advanced].

7	 Select a suitable value from [Media 
Weight] in the [Advanced Options] 
screen, and then click [OK].

Memo

zz Normally, select [Printer Setting]. Select [Printer 
Setting] to use the values set using the printer 
control panel.

zz If outputting to the face-up stacker, open the printer 
face-up stacker, and select [Stacker (Face-Up)] in 
[Output Bin].

8	 Click [OK] in the "Printing preferences" 
screen.

9	 Click [Print] in the "Print" screen to 
print.

��Using Windows PCL Printer 
Drivers

1	 Open the file to be printed using 
WordPad.

2	 Click [Page Setup] in the [File] menu.

3	 Select the paper size and print 
orientation, and click [OK].

4	 Click [Print] in the [File] menu.

5	 Click [Preferences].

6	 Select [Tray 1] in [Source] in the 
[Setup] tab.

7	 Select a suitable value in [Weight], and 
click [OK].

Memo

zz Normally, select [Printer Setting]. Select [Printer 
Setting] to use the values set using the printer 
control panel.

8	 Click [Print] in the "Print" screen to 
print.
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��Using Windows XPS Printer Drivers

1	 Open the file to be printed using 
WordPad.

2	 Click [Page setup] in the [File] menu.

3	 Select the paper size and print 
orientation, and click [OK].

4	 Click [Print] in the [File] menu.

5	 Click [Preferences].

6	 Select [Type] in the [Setup] tab.

7	 Select [Weight], and click [OK].

Memo

zz Normally, select [Printer Setting]. Select [Printer 
Setting] to use the values set using the printer 
control panel.

8	 Click [Print] in the "Print" screen to 
print.
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��Using Mac OS X Printer Drivers

1	 Open the file to be printed using 
TextEdit.

2	 Click [Page Setup] in the [File] menu.

3	 Select the paper size and print 
orientation using the page setup dialog 
box, and click [OK].

4	 Select [Print] in the [File] menu.

5	 Select [Paper Feed] in the print dialog 
box.

6	 Check that [Auto Select] has been 
selected.

7	 Select [Print Options] using the print 
dialog box.

8	 Chick the [Feed] tab in the printer 
setup panel, and select [Media Type] 
and [Media Weight].

Memo

zz Normally, select [Printer Setting]. Select [Printer 
Setting] to use the values set using the printer 
control panel.

9	 Click [Print] to print. 
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zz Printing from the Multi-Purpose Tray

Setting Paper in the Multi-
Purpose Tray

Setting Paper Using the Control 
Panel

If the paper size is "Envelope" or "Custom Size", 
use the control panel to set the paper size.

1	 Press the [Fn] key.

The numerical value input screen will be 
displayed.

2	 Press [9], [0], and click the [OK] 
button.

3	 Select "Paper Size", and click the [OK] 
button.

4	 Press the scroll buttons  to select 
the size of the paper that has been set, 
and press the [OK] button.

5	 Press the [BACK] button to return to 
the previous screen.

6	 Select [Media Type], and press the [OK] 
button.

7	 Press the scroll buttons  to select 
the type of paper that has been set, 
and click the [OK] button.

8	 Press the [BACK] button to return to 
the previous screen.
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9	 Select [Media Weight], and press the 
[OK] button.

10	Press the scroll buttons  to select 
the size of the paper that has been set, 
and press the [OK] button.

11	Press the [BACK] button several times 
to return to the standby screen.

Memo

zz Press the [CANCEL] button to return to the standby 
screen.

Setting Paper

The multi-purpose tray prints to the face-up side 
of the paper that has been set.

Note

zz Do not collate and set paper of different sizes, types, and 
thicknesses at the same time.

Memo

zz If setting custom size paper, it is necessary to register the 
size. For details, see "Advanced".

1	 Open the multi-purpose tray ( ) 
towards you.

2	 Open the auxiliary supporter ( ).

3	 Pull the setting lever ( ) on the right of 
the paper supporter ( ) towards you.
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4	 Adjust the paper guide ( ) to the width 
of the paper that has been set.

5	 Release and return the setting lever ( ) 
to its original position.

6	 Thoroughly sort the paper. Carefully 
align the ends of the paper horizontally.

7	 Place the print side face-up, and set the 
paper.

Note

zz Do not set the paper beyond the MP paper guide ( ).

zz When adding paper, remove the paper in the multi-
purpose tray, and align the additional paper top, bottom, 
left, and right before setting.

zz Do not place anything other than the paper to be printed 
on the multi-purpose tray, apply pressure from above, or 
apply unnecessary force.
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Printing from the Multi-
Purpose Tray

Print to the paper set in the multi-purpose tray. 
The main operating procedures are described 
below.

1	 Set the paper in the multi-purpose tray 
( ) ( ).

2	 Open the file to be printed.

3	 Specify the [Multi-Purpose Tray] using 
the printer drivers to print.

This section explains how to print using the 
multi-purpose tray from the printer drivers.

zz Windows PS printer driver

zz Windows PCL printer driver (P.103)

zz Windows XPS printer driver (P.104)

zz Mac OS X printer driver (P.105)
Further, this explanation uses "WordPad" for 
Windows as the application used. For Mac OS X, 
the example uses "TextEdit".

Reference

zz For how to install the printer drivers, see “Connecting the 
PC” (P.61).

��Using Windows PS Printer Drivers

1	 Open the file to be printed using 
WordPad.

2	 Click [Page setup] in the [File] menu.

3	 Select the paper size and print 
orientation, and click [OK].

4	 Click [Print] in the [File] menu.

5	 Click [Preferences].

6	 Click [Advanced] in the [Layout] tab.
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7	 Select [Paper Size] from [Paper/Output] 
in the [Advanced Options] tab.

8	 Select [Multi-Purpose Tray] in [Paper 
Source] in the [Paper/Quality] tab, and 
click [Advanced].

9	 Select a suitable value from [Media 
Weight] in the [Advanced Options] 
screen, and then click [OK].

Memo

zz Normally, select [Auto]. Select [Auto] to use the 
value set using the printer control panel.

zz To print pages individually, set [Multipurpose tray is 
handled as manual feed] to [Yes].

10	Click [OK] in the "Printing Preferences" 
screen.

11	Click [Print] in the "Print" screen to 
print.
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��Using Windows PCL Printer Drivers

1	 Open the file to be printed using 
WordPad.

2	 Click [Page setup] in the [File] menu.

3	 Select the paper size and print 
orientation, and click [OK].

4	 Click [Print] in the [File] menu.

5	 Click [Preferences].

6	 Select [Size] in the [Setup] tab.

7	 Select [Multipurpose Tray] in [Source].

8	 Click [Paper Feed Options].

Memo

zz To print pages individually, enable [Use MP tray as 
manual feed] in [Multi Purpose Tray Settings], and 
click [OK].

9	 Select a suitable value in [Weight], and 
click [OK].

Memo

zz Normally, select [Printer Setting]. Select [Printer 
Setting] to use the values set using the printer 
control panel.

10	Click [Print] in the "Print" screen to 
print.



- 104 -

Printing from the Multi-Purpose Tray

A
p
p
en

d
ix

S
ettin

g
 U

p

2

B
efo

re U
se

1

Prin
tin

g

3

Basic D
evice O

perations

4

In
d
ex

��Using Windows XPS Printer Drivers

1	 Open the file to be printed using 
WordPad.

2	 Click [Page setup] in the [File] menu.

3	 Select the paper size and print 
orientation, and click [OK].

4	 Click [Print] in the [File] menu.

5	 Click [Preferences].

6	 Select [Multipurpose Tray] in [Source] 
in the [Setup] tab.

7	 Click [Paper Feed Options].

Memo

zz To print pages individually, enable [Use MP tray as manual 
feed] in [Multipurpose Tray Settings], and click [OK].

8	 Select a suitable value in [Weight], and 
click [OK].

Memo

zz Normally, select [Printer Setting]. Select [Printer Setting] 
to use the values set using the printer control panel.

9	 Click [Print] in the "Print" screen to print.
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��Using Mac OS X Printer Drivers

1	 Open the file to be printed using 
TextEdit.

2	 Click [Page Setup] in the [File] menu.

3	 Select the paper size and print 
orientation using the page setup dialog 
box, and click [OK].

4	 Select [Print] in the [File] menu.

5	 Select [Paper Feed] in the print dialog 
box.

6	 Select [Multi-Purpose Tray] in [All Pages 
From].

Memo

zz Normally, select [Auto]. Select [Auto] to use the 
value set using the printer control panel.

7	 Select [Print Options] using the print 
dialog box.

8	 Chick the [Feed] tab in the printer 
setup panel, and select [Media Type] 
and [Media Weight].

9	 Click [Print] to print. 
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zz Outputting Paper
The printer outputs the paper either to the face-down stacker or the face-up stacker.

The face-down stacker can accumulate approx. 620 sheets of GMS 64g/m2 paper.

The face-up stacker can accumulate approx. 300 sheets of GMS 64g/m2 paper.

Using the Face-Down 
Stacker (Print Face Is Down)

The paper is output with the print side face-
down. Papers are stacked in the order in which 
they are printed.

To output from the face-down stacker, specify 
the face-down stacker in "Output Bin" using the 
printer 

��Using Windows PS Printer Drivers

1	 Open the file to be printed.

2	 Click [Preferences] in the "Print" screen.

3	 Select [Stacker (Face-down)] in [Output 
Bin] in the [Job Options] tab, and click 
[OK].

4	 Implement printing.

��Using Windows PCL Printer Drivers

1	 Open the file to be printed.

2	 Click [Preferences] in the "Print" screen.

3	 Select [Stacker (Face Down)] in [Output 
Bin] in the [Job Options] tab, and click 
[OK].

4	 Implement printing.
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��Using Windows XPS Printer Drivers

1	 Open the file to be printed.

2	 Click [Preferences] in the "Print" screen.

3	 Select [Printer (Face Down)] in [Output 
Bin] in the [Job Options] tab, and click 
[OK].

4	 Implement printing.

��Using Mac OS X Printer Drivers
Memo

zz This section uses "TextEdit" as an example.

1	 Open the file to be printed.

2	  Select [Print] in the [File] menu.

3	 Select [Print Options] using the print 
dialog box.

4	 Select [Stacker (Face-down)] in [Output 
Bin] in the [Paper] tab.

5	 Click [Print] to print.

6	 The printed paper will be output to the 
face-down stacker (output tray) ( ).
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Using the Face-Up Stacker 
(Print Face Is Up)

The paper is output with the print side face-
up. Paper is stacked in the reverse order from 
printing.  
To output from the face-up stacker, specify the 
face-up stacker in [Output Bin] using the printer 
drivers.

1	 Open the face-up stacker ( ) on the 
left of the printer.

2	 Open the paper supporter ( ) as 
shown in the diagram.

3	 Rotate the auxiliary supporter ( ) in 
the direction of the arrow until its lock 
position.

4	 Open the file to be printed.

Customers using Mac OSX go to “Using 
Windows PS Printer Drivers” Step 5.

5	 Click [Advanced] in the "Print" screen.

��Using Windows PS Printer Drivers

6	 Select [Stacker (Face-up)] in [Output 
Bin] in [Job Options], and click [OK].

7	 Implement printing.

��Using Windows PCL Printer Drivers

6	 Select [Stacker (Face Up)] in [Output 
Bin] in [Job Options], and click [OK].

7	 Implement printing.
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��Using Windows XPS Printer Drivers

6	 Select [Printer (Face Up)] in [Output 
Bin] in [Job Options], and click [OK].

7	 Implement printing.

��Using Mac OS X Printer Drivers
Memo

zz This section uses "TextEdit" as an example.

5	 Select [Print] in the [File] menu.

6	 Select [Print Options] using the print 
dialog box.

7	 Select [Stacker (Face-up)] in [Output 
Bin] in the [Paper] tab.

8	 Click [Print] to print.

Printed paper is output to the face-up 
stacker.
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��Memo
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4.Basic Device Operations
This chapter explains how to set power save mode, which reduces device power consumption, how 
to check print quantities, the service life of consumables, remaining maintenance unit quantities and 
service life, and how to cancel printing.

You can set the printer to enter power save mode from the standby screen. Further, you can also set 
the printer to enter sleep mode from power save mode.

zz Setting Power Save Mode

Setting Power Save Mode
The device can be set to enter power save mode 
from standby mode when no printing or data has 
been received after a fixed period of time.

The default factory setting is to enable power 
save, so implementing this procedure is 
unnecessary.

1	 Press the scroll button  or .

2	 Select [Admin Setup], and press the 
[OK] button.

3	 Enter the administrator password, and 
press the [OK] button.

Memo

zz In the default factory settings, the administrator 
password is [aaaaaa].

4	 Select [Power Setup], and press the 
[OK] button.

5	 Select [Power Save], and press the [OK] 
button.
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6	 Select [Enable], and press the [OK] 
button.

7	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz Other items can also continue to be set before 
pressing the [ON LINE] button.

Setting the time before the 
printer enters power save mode

You can set the time until power save mode is 
entered.

The default factory setting is "1 min."

Lengthening the time until power save mode 
is entered may shorten the time until printing 
starts.

1	 Press the [Fn] key.

The numerical values input screen will 
be displayed.

2	 Enter [2], [0], [0], and press the [OK] 
button.

3	 Select the time to be set, and press the 
[OK] button.
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4	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz The settable times are described below.  
1 min., 2 mins., 3 mins., 4 mins., 5 mins., 10 mins., 15 
mins., 30 mins., 60 mins.

Setting sleep mode
The device can be set to enter sleep mode from 
power save mode when no printing or data has 
been received after a fixed period of time.

The default factory setting is to enable sleep, so 
implementing this procedure is unnecessary.

1	 Press the scroll button  or .

2	 Select [Admin Setup], and press the 
[OK] button.

3	 Enter the administrator password, and 
press the [OK] button.

Memo

zz In the default factory settings, the administrator 
password is [aaaaaa].

4	 Select [Power Setup], and press the 
[OK] button.
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5	 Select [Sleep], and press the [OK] 
button.

6	 Select [Enable], and press the [OK] 
button.

7	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz Other items can also continue to be set before 
pressing the [ON LINE] button.

Setting the time before the 
printer enters sleep mode

You can set the time until sleep mode is entered.

The default factory setting is "15 min."

Lengthening the time until sleep mode is entered 
may shorten the time until printing starts.

1	 Press the [Fn] key.

The numerical values input screen will 
be displayed.

2	 Enter [2], [0], [1], and press the [OK] 
button.

3	 Select the time to be set, and press the 
[OK] button.
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4	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz The settable times until sleep mode is entered are 
described below.  
1 min., 2 mins., 3 mins., 4 mins., 5 mins., 10 mins., 15 
mins., 30 mins., 60 mins.
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Restrictions in sleep mode
This section explains the restrictions when the device is in sleep mode.

When the device is displaying an error, entering sleep mode may be disabled.

Printer driver utility restrictions

When the device enters sleep mode, the printer driver and utility functions are restricted as described 
below.

OS Software name Restrictions in sleep mode
Windows Configuration Tool Network settings for the Network Setting plug-in are disabled.

Network Extension Cannot connect to device.

Driver installer When connected to a network, the device options information cannot be 
acquired while installing the printer drivers.

Mac OS X NIC Setup Tool Printer searches and settings are disabled.

Printer drivers Printing is disabled when connected using EtherTalk. Connect to the 
device using either Bonjour (Rendezvous) protocols or LPD protocols 
(TCP/IP).
For advanced setup methods, see either “Using Bonjour (Rendezvous)” 
(P.78) or “Adding Printers Using LPD (TCP/IP) Protocols” (P.123).

When the device enters sleep mode, press the [POWER SAVE] button on the control panel to check that 
"Printing enabled" is displayed on the liquid crystal panel.

When "Printing enabled" is displayed, the restrictions described above do not apply.
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Network function restrictions

In sleep mode, the following restrictions apply to 
the network functions.

��Sleep mode is disabled
In the following cases, the device cannot enter 
sleep mode.

zz IPSec is enabled.

zz A TCP connection has been established.
Example: A connection has been established 
using Telnet or FTP, etc.

After the period for entry to power save mode 
has elapsed in energy save mode, the printer will 
enter sleep mode when the connection is cut.

Memo

zz To enable sleep mode, disable IPSec.

��Unable to print
While in sleep mode, printing using the following 
protocols is disabled.

zz NBT

zz EtherTalk*

zz WSD Print
*: For Mac OS X, printing while in sleep mode is possible if 

connected using Bonjour (Rendezvous) protocols or "LPD 
protocols (TCP/IP).  
For setup methods, see either “Using Bonjour 
(Rendezvous)” (P.78) or “Setting Power Save Mode” 
(P.111).

��Unable to search/setup
While in sleep mode, searches and settings 
using the following functions and protocols are 
disabled.

zz PnP-X

zz UPnP

zz LLTD

zz MIB*
*: Referencing using the parts of MIB (Get command) that 

are supported is possible is sleep mode.

��Protocols with client functions do 
not operate

While in sleep mode, the following protocols with 
client functions do not operate.

zz E-mail alert*1

zz SNMP Trap

zz WINS*2
*1: 	The elapsed time while in sleep mode does not include 

the intervals between periodic communications times for 
e-mail alerts.

*2: 	The elapsed time while in sleep mode does not include 
the intervals between WINS refresh times.  
WINS is not periodically refreshed while in sleep mode, 
so the names registered to the WINS server may be 
deleted.

��Moving automatically from sleep 
mode to power save mode

In network environments with flows of large 
packet quantities, the device may move 
automatically from sleep mode to power save 
mode and respond.

Subsequently, if the period for moving to 
sleep mode elapses, sleep mode is entered 
automatically.
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zz Setup to Turn OFF the Power Supply Automatically

Setting auto power OFF 
mode

The device can be set to enter OFF mode 
automatically when no printing or data has been 
received after a fixed period of time.

In the default factory settings, auto power OFF 
mode is set automatically. Set according to the 
conditions for entering OFF mode.

"Enable": Enters OFF mode automatically

"Auto Config": Enters OFF mode when the set time has 
elapsed. If using a network connection, 
however, OFF mode is not entered even 
when the set time has elapsed.

"Disable": The power supply does not turn OFF 
automatically.

1	 Press the scroll button  or .

2	 Select [Admin Setup], and press the 
[OK] button.

3	 Enter the administrator password, and 
press the [OK] button.

Memo

zz In the default factory settings, the administrator 
password is [aaaaaa].

4	 Select [Power Setup], and press the 
[OK] button.

5	 Select [Auto Power Off], and press the 
[OK] button.

6	 Select [Enable] or [Auto Config], and 
press the [OK] button.
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7	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz Other items can also continue to be set before 
pressing the [ON LINE] button.

Setting the time before the printer 
enters auto power OFF mode

You can set the time until OFF mode is entered.

The default factory setting is "4 hours".

1	 Press the [Fn] key.

The numerical values input screen will 
be displayed.

2	 Enter [2], [0], [2], and press the [OK] 
button.

3	 Select the time to be set, and press the 
[OK] button.

4	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz The settable times are described below.  
1 hour, 2 hours, 3 hours, 4 hours, 8 hours, 12 hours, 18 
hours, 24 hours
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zz Checking print quantities
You can check the quantity of printed paper to date.

You can also check the quantities printed (fed) from each tray.

1	 Press the scroll button  or .

2	 Select [Configuration], and press the 
[OK] button.

3	 Select [Tray Count], and press the [OK] 
button.

4	 Select the tray to be checked.

5	 Press the [OK] button.

To continue checking other items, press 
the [BACK] button and return to 4.

6	 Press the [ON LINE] button to return to 
the standby screen.



Checking Consumables, and Remaining Maintenance Unit Quantities and Service Life

A
p
p
en

d
ix

S
ettin

g
 U

p

2

Prin
tin

g

3

B
efo

re u
se

1

Basic D
evice O

perations

4

In
d
ex

- 121 -

zz Checking Consumables, and Remaining 
Maintenance Unit Quantities and Service Life

You can check the remaining quantities and service life of the toner, image drum, belt unit, fixer unit, 
and waste toner box.

1	 Press the scroll button  or .

2	 Select [Configuration], and press the 
[OK] button.

3	 Select [Supplies Life], and press the 
[OK] button.

4	 Select the consumable or maintenance 
unit (image drum, belt unit, fixer unit, 
or waste toner box) to be checked.

5	 Press the [OK] button.

To continue checking other items, press 
the [BACK] button and return to 5.

6	 Press the [ON LINE] button to return to 
the standby screen.

Memo

zz The value to the right of the toner in the remaining 
consumables quantity screen changes depending on 
the type of toner cartridge installed.  
"10.0K" is displayed at the time of product purchase 
and when a standard toner cartridge is mounted.  
"24.0K" is displayed when a large-capacity toner 
cartridge is mounted.
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zz Canceling Printing
To cancel data while printing or during print 
preparation, press the [CANCEL] button on the 
control panel.

When the [CANCEL] button is pressed, the 
following screens will be displayed.

To cancel printing, select [Yes], and press the 
[OK] button.

To continue printing, select [No], and press the 
[OK] button.

If no operation is implemented within 3 mins. 
while this screen is displayed, the screen display 
will disappear and printing will continue.
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zz Adding Printers Using LPD (TCP/IP) Protocols
With Mac OS X environments, you can connect printers using LPD protocols (TCP/IP).

Apple Talk cannot be used with Mac OS X 10.6 or later, so for network connections, connect the printer 
using Bonjour (Rendezvous) protocols or LPD protocols (TCP/IP).

Preparations

1	 Check that the IP address, subnet 
mask, and router address, etc., have 
been set correctly for the desired Mac 
OS, and that you are connected to the 
network using LPD protocols (TCP/IP).

2	 Download the PPD installer for Mac 
OS X for the printer to be connected 
from the OKI Data homepage (http://
www.okidata.co.jp/), unzip and start 
the PPF installer, and then install PPD 
on the relevant Mac OS. This step is 
unnecessary if PPD is already installed.

3	 Set the IP address, subnet mask, and 
gateway address, etc., on the printer to 
be connected. Make sure the printer is 
turned ON, and connected to the TCP/
IP network environment.

Procedure for Adding 
Printers

1	 Open the Mac OS system environment 
settings, and click the "Print & Scan" 
icon to open the "Print & Scan" screen.

2	 Click the [+] button to open the "Add 
printer" screen.

http://www.okidata.co.jp/
http://www.okidata.co.jp/
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3	 Select the [IP] icon. The following screen 
will be displayed. Enter the printer IP 
address, "Queue" name, and "Name", 
and then check that the printer to be 
used is selected in "Use", and click the 
[Add] button.

(1)

(2)

(3)

(4)

(1)	 Enter the IP address allocated 
to the printer in the client 
environment.

(2)	 Enter "Ip" as the queue name.

(3)	 The IP address entered in Step (1) 
will be displayed. Enter any desired 
name.

This explanation uses C931 (LPD) 
as an example.

(4)	 The printer to be used (PS) will 
be displayed automatically as the 
driver.

If you cannot communicate 
properly with the printer, auto 
selection will not be implemented.

Note

zz When the printer is in sleep mode, the drivers may 
not be selected correctly. Return the printer from 
sleep mode, and then enter the printer IP address 
in [Address].

4	 Set the printer options, and click [OK].

5	 The "Print & Scan" screen will be 
displayed, and the printer to be used 
(LPD) will be added to the printer list. 
Select the printer to be used (LPD) as 
the "Default printer".

This way, the desired printer will be 
used as the default when printing. This 
completes the procedure for adding 
a printer, so close the "Print & Scan" 
screen.
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Appendix

zz Table of control panel menu items
Numbers following the letter F in the menu items indicate the function number.

Configuration

 Tray Count MPTray
Tray1  
Tray2 *1  
Tray3 *1

Tray4 *1

Tray5 *1

 Supplies Life Cyan Toner (n.nK) 
Magenta Toner (n.nK)
Yellow Toner (n.nK)
Black Toner (n.nK)
White Toner (n.nK) *2 *4

Clear Toner (n.nK) *3 *4

Cyan Drum  
Magenta Drum  
Yellow Drum  
Black Drum  
White Drum *2 *4 
Clear Drum *3 *4

Waste Toner Box
Belt  
Fuser  

 Network Printer Name  
Short Printer Name  
IPv4 Address
Subnet Mask
Gateway Address
MAC Address  
Network FW Version  
Web Remote Version  
IPv6 Address (Local)  
IPv6 Address (Global)  

 Paper Size in Tray MPTray
Tray1  
Tray2 *1  
Tray3 *1 
Tray4 *1

Tray5 *1

 System Serial Number  
Asset Number  
CU Version  
PU Version  
RAM  
Flash Memory  
HDD  
Date and Time

*1: Displayed when trays 2 to 5 are mounted.

*2: Displayed when using white toner in C941/ES9541dn.

*3: Displayed when using clear toner in C941/ES9541dn.

*4: Not displayed with C911/C931/ES9411dn/ES9431dn.
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Print Information

Configuration
Network
Demo Page
File List
PS Font List  
PCL Font List  
Usage Report
Error Log
Color Profile List
User Media List
Test Print-1  
Test Print-2  
Test Print-3 *1 

Print
Print
DEMO1
Print
Print
Print
Print
Print
Print
Print
Print
Print
Print 

Print

F100

F101

F102

F103

*1: Displayed with C941/ES9541dn.

Print Secure Job *1

 Encrypted Job Enter Password Not Found
Print
Delete

 Stored Job Enter Password Not Found
Print
Delete

F1

F2

*1: Displayed when the built-in HDD is mounted.
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Menus

 Tray Configuration Paper Size (A4     )MPTray Config
X Dimension *3 (210mm/8.3") 
Y Dimension *3 (297mm/11.7")  
Media Type (Medium Light)  
Media Weight (Auto)  
Tray Usage (Normal Tray) 

Tray1 Config Paper Size (Cassette Size)
X Dimension *3 (210mm/8.3") 
Y Dimension *3 (297mm/11.7")  
Media Type (Medium Light)  
Media Weight (Auto)  
A3Nobi Paper
Legal14 Paper (Legal14)
A5LEF/A6/Hagaki Paper (A5     )  
A5SEF/Oufuku Hagaki Paper (A5    ) 
Other Size (B6)

Tray2 Config *1

Tray3 Config *1

Tray4 Config *1

Tray5 Config *1

Paper Feed (Tray1) 
Auto Tray Switch (On) 
Tray Sequence (Down) 
Unit of Measurement (mm) 
Duplex Last Page (Skip Blank Page)

Paper Size (Cassette Size)
X Dimension *3 (210mm/8.3") 
Y Dimension *3 (297mm/11.7")  
Media Type (Medium Light)  
Media Weight (Auto)  
A3Nobi Paper
Legal14 Paper (Legal14)
A5LEF/A6/Hagaki Paper (A5     )  
A5SEF/Oufuku Hagaki Paper (A5    ) 
Other Size (B6)

Paper Size (Cassette Size)
X Dimension *3 (210mm/8.3") 
Y Dimension *3 (297mm/11.7")  
Media Type (Medium Light)  
Media Weight (Auto)  
A3Nobi Paper
Legal14 Paper (Legal14)
A5LEF/A6/Hagaki Paper (A5     )  
A5SEF/Oufuku Hagaki Paper (A5    ) 
Other Size (B6)

Paper Size (Cassette Size)
X Dimension *3 (210mm/8.3") 
Y Dimension *3 (297mm/11.7")  
Media Type (Medium Light)  
Media Weight (Auto)  
A3Nobi Paper
Legal14 Paper (Legal14)
A5LEF/A6/Hagaki Paper (A5     )  
A5SEF/Oufuku Hagaki Paper (A5    ) 
Other Size (B6)

Paper Size (Cassette Size)
X Dimension *3 (210mm/8.3") 
Y Dimension *3 (297mm/11.7")  
Media Type (Medium Light)  
Media Weight (Auto)  
A3Nobi Paper
Legal14 Paper (Legal14)
A5LEF/A6/Hagaki Paper (A5     )  
A5SEF/Oufuku Hagaki Paper (A5    ) 
Other Size (B6)

F90

F91

F92

F93

F94

F95

F10

F11

F12

F13

F14

F15

F16

F17

F18

F19

F20

F21

F22

F23

F24

F25

F26

F27

F28

F29

F30

F31

F32

F33

F34

F35

F36

F37

F38

F39

F40

F41

F42

F43

F44

F45

F46

F47

F48

F49

F50

F51

F52

F53

F54

F55

F56

F57

F58

F59

F80

Continue to next page
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 Panel Setup Power Save Time (1 minute)  
Sleep Time (15 minutes)
Auto Power Off Time (4 hours)
Clearable Warning (ONLINE)
Auto Continue (Off)
Manual Timeout (60 seconds)
Wait Timeout (40 seconds)  
Low Toner (Continue)  
Jam Recovery (On)  
Error Report (Off)  
Hex Dump         Execute

 Print Adjust Print Position Adjust MPTray X Adjust (0.00mm)  
Y Adjust (0.00mm)    
Duplex X Adjust *1 (0.00mm)    
Duplex Y Adjust *1 (0.00mm)    
Overprint X Adjust *1 (0.00mm)    
Overprint Y Adjust *1 (0.00mm)    

X Adjust (0.00mm)  
Y Adjust (0.00mm)    
Duplex X Adjust *1 (0.00mm)    
Duplex Y Adjust *1 (0.00mm)    
Overprint X Adjust *1 (0.00mm)    
Overprint Y Adjust *1 (0.00mm)    

X Adjust (0.00mm)  
Y Adjust (0.00mm)    
Duplex X Adjust *1 (0.00mm)    
Duplex Y Adjust *1 (0.00mm)    
Overprint X Adjust *1 (0.00mm)    
Overprint Y Adjust *1 (0.00mm)    

X Adjust (0.00mm)  
Y Adjust (0.00mm)    
Duplex X Adjust *1 (0.00mm)    
Duplex Y Adjust *1 (0.00mm)    
Overprint X Adjust *1 (0.00mm)    
Overprint Y Adjust *1 (0.00mm)    

X Adjust (0.00mm)  
Y Adjust (0.00mm)    
Duplex X Adjust *1 (0.00mm)    
Duplex Y Adjust *1 (0.00mm)    
Overprint X Adjust *1 (0.00mm)    
Overprint Y Adjust *1 (0.00mm)    

X Adjust (0.00mm)  
Y Adjust (0.00mm)    
Duplex X Adjust *1 (0.00mm)    
Duplex Y Adjust *1 (0.00mm)    
Overprint X Adjust *1 (0.00mm)    
Overprint Y Adjust *1 (0.00mm)    

Tray1

Tray2 *2

Tray3 *2

Tray4 *2

Tray5 *2

Paper Black Setting (0)  
Paper Color Setting (0)  
Trans. Black Setting (0)  
Trans. Color Setting (0)  
SMR Setting (0)  
BG Setting (0)  
Drum Cleaning (Off) 
Transfer Roller Cleaning
High Humid Mode (Off) 
Moisture Control (Off) 
Narrow Paper Speed (Slow) 
Print Mode (Normal) 

F201

F200

F202

F210

F237

F230

F231

F232

F233

F234

F235

F236

F238

F220

F221

F222

F223

F224

F225

        Execute

*1: Displayed when the duplex print unit is mounted.

*2: Displayed when trays 2 to 5 are mounted.

*3: Displayed when [Paper size] is set to [Custom].
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Admin Setup

 Network Setup TCP/IP (Enable)
NetBIOS over TCP (Enable)
EtherTalk (Disable)
IP Address Set (Auto)
IPv4 Address (xxx.xxx.xxx.xxx)
Subnet Mask (xxx.xxx.xxx.xxx)  
Gateway Address (xxx.xxx.xxx.xxx)  
Web (Enable)
Telnet (Disable)
FTP (Disable) 
IPSec (Disable)   
SNMP (Enable) 
Network Scale (Normal)
Gigabit Network (Disable) 
Hub Link Setting (Auto)
Network Factory Defaults Execute

 USB Setup USB (Enable)
Speed (480Mbps)
Soft Reset (Disable)
Serial Number (Enable)
Offline Receive (Disable)

 Print Setup Personality (Auto)
Copies (1)
Duplex  (Off) *1

Binding (Long Edge) *1

Job Offset (Off)
Output Bin (Face Down)
Media Check (Enable)
A4/Letter Override (Yes)
Resolution (600dpi)
Toner Save Toner Save Level (Off)

Color (All)
Mono-Print Mode (Auto)
Default Orientation (Portrait)
Form Length (64 lines)
Edit Size (Cassette Size)  
Trapping (Off)  
X Dimension (210mm/8.3") 
Y Dimension (297mm/11.7")   

Continue to next page



Table of control panel menu items

A
p
p
en

d
ix

Prin
tin

g

3

S
ettin

g
 U

p

2

B
efo

re u
se

1

Basic D
evice O

perations

4

In
d
ex

- 130 -

 PS Setup Network Protocol (RAW)
USB Protocol (RAW)

 PCL Setup Font Source (Resident2)
Font Number (C1)
Font Pitch (10.00CPI)
Font Height (12 point)
Symbol Set (WIN3.1J)
A4 Print Width (78 column)
White Page Skip (Off)
CR Function (CR)
LF Function (LF)
Print Margin (Normal)
True Black (Off)  
Pen Width Adjust (Off) 
Tray ID# MPTray (4)

Tray1  (1)
Tray2  *2 (5)
Tray3 *2 (20)
Tray4 *2 (21)
Tray5 *2 (22) 

 XPS Setup DigitalSignature (Off)  
DiscardControl (Auto)  
MC Mode (On)  
Unzip Mode (Speed)  
White Page Skip (Off)  

 Color Setup Ink Simulation (Off) 
UCR (Low)
CMY 100% Density (Disable)
CMYK Conversion (On)
Spot Color *3 (White)

 Panel Setup Near Life Status (Enable)
Near Life LED (Enable)
Idle Display (Toner Gauge)
Panel Brightness During Operating (31)
Panel Brightness While Power Save (1)
Panel Backlight Timer (30)
Front Lamp (Mode1)

 Time Setup Date Format (yyyy/mm/dd)
Time Zone (+0:00) *4

Daylight Saving (Off)  
Time Setting (2000/01/01 00 :00) *4 

 Power Setup Power Save (Enable)
Sleep (Enable)
Auto Power Off (Auto Config)

Continue to next page
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 Others Setup RAM Setup Receive Buffer Size (Auto)
Resource Save (Off) 

Initialize  
Resize PS Area 

Flash Memory Setup Execute
nn% [n.n MB]

Execute

Execute

Execute
Execute

Execute
Execute
Execute

Execute
Execute
Execute

HDD Setup *5 Initialize  
Resize Partition  

Execute
PCL nn% (20%)
Common mm% (50%)
PS ll% (30%)
<Apply>

Format Partition (PCL)
Erase HDD

Storage Common Setup Check File System *5

Check All Sectors *5

Enable Initialization (No)

Security Setup *5 Job Limitation (Off) 
Make Secure HDD  
Make Normal HDD  
Reset Cipher Key

Language Setup Language Initialize

Font Setup Font Output Mode (JIS2004)

Job Cancel Setup Cancel Key Behavior (Shortt)  
Inquiry Display (Long)  
Focus Position (Yes)  
Display Timeout (180)  

 Settings Reset Settings  
Save Settings  
Restore Settings *6  

 Change Password New Password  
Verify Password  

*1: Displayed when the duplex print unit is mounted.

*2: Displayed when trays 2 to 5 are mounted.

*3: Not displayed with C911/C931/ES9411dn/ES9431dn.

*4: The time zone and time are set at the factory.

*5: Displayed when the HDD is mounted.

*6: Displayed when "Save setup" has been implemented.

Print Statistics

Execute

Execute

JOB LOG (Enable)

Supplies Report (Disable)

Reset Main Counter

Reset Supplies Counter

Change Password New Password  
Verify Password
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Calibration

Auto Density Mode (On)  
Auto BG Adjust Mode (0)  
Adjust Density  
Adjust Registration  
Heavy Media Adjust (Off)   
Heavy Media Mode (Auto)
Color Density

Execute
Execute

Execute

Execute

Cyan Density (0)  
Magenta Density (0)  
Yellow Density (0)  
Black Density (0)  
White Density *1 *3 (0)  
Clear Density *1 *3 (0)  
Print Color Tuning Pattern

 Base Color Tuning Highlight (A-1)  
Mid-Tone (A-1)  
Dark (A-1)  

Highlight (0)  
Mid-Tone (0)  
Dark (0)  

Highlight (0)  
Mid-Tone (0)  
Dark (0)  

Highlight (0)  
Mid-Tone (0)  
Dark (0)  

Highlight (0)  
Mid-Tone (0)  
Dark (0)  

Highlight (0)  
Mid-Tone (0)  
Dark (0)  

 Fine Color Tuning Cyan Tuning

Magenta Tuning

Yellow Tuning

Black Tuning

 Reset Color Tuning 

 White Tuning *1 *3  

F300

F301

F310

F311

F312

F313

F314

F314

F302

*1: Displayed when using white toner in C941/ES9541dn.

*2: Displayed when using clear toner in C941/ES9541dn.

*3: Not displayed with C911/C931/ES9411dn/ES9431dn.

Boot Menu

Network Factory Defaults
HDD Setup
Storage Common Setup

Menu Lockout (Off)
Panel Lockout (Off)

Execute
Enable HDD (Yes)
Check File System
Check All Sectors

Execute
Execute

*: Displayed when the power supply is turned ON while the [OK] button is being pressed.

	 Boot Menu is displayed in English only.
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zz Basic Windows Functions
This section explains the procedures for displaying the drivers setup window from the [Printers]/[Printer 
and Fax] folder for OS other than Windows 7, which is used as an example in this manual.

Memo

zz The Windows Server 2008 R2 procedure is the same as for Windows 7.

zz If installing multiple drivers, the icon will be displayed for each driver in the [Printers]/[Printer and Fax] folder. Use the 
following procedure for the drivers to be set up and checked.

Displaying the Properties 
Window

��Windows 8/Windows Server 2012

1	 Click [Setup], and select [Control 
panel]> [Show devices and printers].

2	 Right-click the OKI C931 icon, and 
select [Printer properties].

��Windows Vista/Windows Server 
2008

1	 Click the [Start] button, and select 
[Control panel]> [Printers].

2	 Right-click the OKI C931 icon, and 
select [Properties].

��Windows XP/Windows Server 
2003

1	 Click [Start], and then select [Printers 
and Fax].

2	 Right-click the OKI C931 icon, and 
select [Properties].

Displaying the print setup 
window

��Windows 8/Windows Server 2012

1	 Click [Setup], and select [Control 
panel]> [Show devices and printers].

2	 Right-click the OKI C931 icon, and 
select [Printing preferences].

��Windows Vista/Windows Server 
2008

1	 Click the [Start] button, and select 
[Control panel]> [Printers].

2	 Right-click the OKI C931 icon, and 
select [Printing preferences].

��Windows XP/Windows Server 
2003

1	 Click [Start], and then select [Printers 
and Fax].

2	 Right-click the OKI C931 icon, and 
select [Printing preferences].
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zz Specifications

Main specifications

Model C911dn/C931dn/ES9411dn/ES9431dn: N36100A(120V), N36100B(230V), N36100C(100V)
C941dn/ES9541dn:                             N36101A(120V), N36101B(230V), N36101C(100V)

CPU C911/ES9411dn:                          ARM Processor (1GHz)
C931/C941/ES9431dn/ES9541dn: ARM Processor (1.2GHz)

RAM (standard/ 
max.)

2GB/2GB

Weight C911/C931/ES9411dn/ES9431dn: Approx. 82kg (not including consumables)*1

C941/ES9541dn:                          Approx. 91kg (not including consumables)*2

Power 110 to 127 VAC (Range 99 to 140 VAC), 50/60 Hz ± 2% 
220 to 240 VAC (Range 198 to 264 VAC), 50/60 Hz ± 2%

Power consumption During operations: 1,500W max./Average 1,100W

During standby:     Average 90W

In power save mode
  In power save mode: 30W max.
  In sleep mode:          4W max. (factory settings)
  In Auto Power OFF:    0.4W max.

* The product does not consume power when the main power switch is OFF, even if the power plug is 
inserted into the outlet.

Use environment 
conditions

Temperature 10ºC to 32ºC, humidity 20% to 80%RH
Max. wet bulb temperature 25ºC (Environments where high-quality and full color are 
assured : Temperature 17ºC to 27ºC, humidity 50% to 70%RH)

Network connection 1000BASE-T/100BASE-TX/10BASE-T (Factor y settings 100BASE-TX/10BASE-T)

Local connections USB2.0 interface (Hi-Speed USB supported)

Display 4.3" high-resolution color LCD (480x272dots)

Compatible OS Windows 8/Windows 7/Windows Vista/Windows XP/Windows Server 2012/
Windows Server 2008 R2/Windows Server 2008/Windows Server 2003
Mac OS 9.2, 9.2.1, 9.2.2, Mac OS X 10.3.9 to 10.8
For details, see the operations environment.

Print method C911/C931/ES9411dn/ES9431dn: Dry electronic photo method using 4 continuous digital LED heads
C941/ES9541dn:                          Dry electronic photo method using 5 continuous digital LED heads

Resolution Print 
resolution

1200 x 1200dpi (2 shades) / 1200 x 600dpi (16 shades) / 600 x 600dpi (2 shades)

LED dot pitch 1200dpi

Print colors Yellow, magenta, cyan, black, white*3, clear*3

Print languages PostScript3, PCL6 (PCLXL3.0, PCL5c), PDF1.7, XPS
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C911dn/
ES9411dn

C931dn/
ES9431dn

C941dn/
ES9541dn

Print 
speed**4

Color 
(1-sided)

CMYK 50 pages/min. (A4 landscape feed), 28 pages/min. (A3 
portrait feed)
(If auto paper weight is set)

CMYK+1 color

-

CMYK+Spot Color 
white:
45 pages/min.
(A4 landscape 
feed),
25 pages/min.
(A3 portrait feed)
CMYK+Spot Color 
clear:
18 pages/min.
(A4 landscape feed)

Spot Color overprint*5

(CMYK+Spot Color white) -

45 pages/min.
(A4 landscape feed)
6 pages/min.
(A3 portrait feed)

Monochrome (1-sided) 50 pages/min. (A4 landscape feed)
28 pages/min. (A3 portrait feed)
(If auto paper weight is set)

Auto 
2-Sided 
Printing

CMYK Color: 50 pages/min. (A4 landscape feed)
Monochrome: 50 pages/min. (A4 landscape feed)
Color: 28 pages/min. (A3 portrait feed)
Monochrome: 28 pages/min. (A3 portrait feed)
(If auto paper weight is set)

(CMYK+Spot Color 
white)*6

-

*CMYK+Spot Color 
white 
is compatible with 
single color only
45 pages/min.
( A 4  l a n d s c a p e 
feed),
25 pages/min.
(A3 portrait feed)

Spot Color overprint
(CMYK+Spot Color white) -

Type of 
paper*7

Paper 
quality*8

Plain, thick paper (glossy*9, transparent film*10, transparencies*11, postcards, labels*12, 
envelopes*13)

Paper size A3NOBI, 13×18", A3WIDE (SRA3), A3, A4WIDE (SRA4), A4, A5, A6, B4, B5, B6, letter, 
legal13/13.5/14, Executive, 
Statement*14, Tabloid Extra, Tabloid, 8K, 16K, envelopes*15, postcards, 
Japanese double postcards, 4-REN Hagaki, index cards*14, B6 half*14, custom*16

GSM paper 
weight

1st tray: GSM 52 to 320g/m2 (ream weight 45 to 275kg)
Expansion tray unit: GSM 52 to 320g/m2 (ream weight 45 to 275kg)
Large-capacity expansion tray unit: GSM 52 to 320g/m2 (ream weight 45 to 275kg)
Multi-Purpose Tray: GSM 52 to 360g/m2 (ream weight 45 to 309kg)

Auto 
2-Sided
Print 
Functions

Paper size A3NOBI, 13×18", A3WIDE (SRA3), A3, A4WIDE (SRA4), A4, A5, A6 portrait feed, B4, 
B5, B6, letters, legal13/13.5/14), Executive, 
Statement, Tabloid Extra, Tabloid, 8K, 16K, postcards, Japanese double postcards,
4-REN Hagaki, Custom*17

GSM paper 
weight

1st tray: GSM 64 to 320g/m2 (ream weight 55 to 275kg)
Expansion tray unit: GSM 64 to 320g/m2 (ream weight 55 to 275kg)
Large-capacity expansion tray unit: GSM 64 to 320g/m2 (ream weight 55 to 275kg)
Multi-Purpose Tray: GSM 64 to 320g/m2 (ream weight 55 to 275kg)
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Paper 
feed 
method/
Feed 
quantity

Multi-purpose 
tray

Capacity 310 sheets (GSM weight 64g/m2, total thickness 31mm max.)*18

1st
 tray

Capacity 580 sheets (GSM weight 64g/m2, total thickness 53mm max.)*19

Expansion 
tray
 unit

(Optional) Capacity 580 sheets (GSM weight 64g/m2, total thickness 53mm max.)*20

Large-
capacity 
expansion
 tray unit

(Optional) Capacity 580 sheets x 3 trays (GSM weight 64g/m2, total thickness 53mm 
max.)

Paper 
feed 
method/
Output 
capacity

Face down 620 sheets max. (GSM weight 64g/m2)

Face up 300 sheets max. (GSM weight 64g/m2)

Assured print range 6.35mm from the paper edge (excluding special paper such as envelopes, etc.)

Print accuracy Write position accuracy ±2mm; paper slant: ±1mm/100mm
Image expansion and contraction ±1mm/100mm (GSM weight 80g/m2)

Warm-up time Approx. 50s (max.) after power is turned ON (At room temperature 25ºC and rated 
voltage)*21

Average print quantity 25,000 sheets/month

Use environment 
conditions

Temperature 10ºC to 32ºC, humidity 20% to 80%RH, max. wet bulb temperature 25ºC 
(Environments where high-quality and full color are assured : Temperature 17ºC to 
27ºC, humidity 50% to 70%RH)

Consumables and 
maintenance products

Consumables, toner cartridge, image drum,
maintenance products, fixer unit, transfer roller unit, belt unit, paper feed roller set,
waste toner box

Device service life*22 5 years or 1.5 million pages

*1: The total weight including consumables is approx. 97kg.

*2: The total weight including consumables is approx. 117kg.

*3: C941/ES9541dn specifications only.

*4: Plain paper, in copy mode print speed is slower for postcards, envelopes, and card stock.

*5: The mode that prints white before CMYK. If the paper size exceeds B4, the print speed is slower.

*6: Compatible with plain and glossy paper only.

*7: Print quality and paper traction may suffer depending on the paper used and the use environment. Implementing a test print 
beforehand is recommended. Consult your supervisor if anything is unclear.

*8: Printing is not possible to glossy (excluding excellent gloss), coated paper (gloss, matte, dull, and silk), and embossed paper. 
If printing Spot Color white or Spot Color clear using a single color, the K drum will also rotate normally.

*9: For glossy paper, use excellent gloss. Further, use excellent gloss in an indoor environment at 25ºC max., humidity 60% max. 
Print quality may be reduced in any other environments.

*10: Compatible with Multi-Purpose Tray only. 

*11: Compatible with 1st tray and Multi-Purpose Tray only.

*12: Compatible with A4 and letter only.

*13: Compatible with Multi-Purpose Tray only. The paper may curl or crease after printing.

*14: Compatible with Multi-Purpose Tray only.

*15: Nagagata #3, Nagagata #4, Nagagata #40, Yougata #0, Yougata #2, Yougata #4, Younaga #3, Kakugata #2, Kakugata #3, 
Kakugata #6, Kakugata #8, C4, C5, DL, COM-9, COM-10 Monarch.

*16: 1st tray, expansion tray unit, large-capacity expansion tray unit: Width 100 to 330mm x length 148 to 457mm. 
Multi-Purpose Tray: Width 64 to 330mm x length 90 to 1,321mm. If using Spot Color overprint, length is 182 to 457mm.

*17: 1st tray, expansion tray unit, large-capacity expansion tray unit: Width 100 to 330mm x length 148 to 457mm. 
Multi-Purpose Tray: Width 64 to 330mm x length 90 to 483mm.

*18: Postcards x 110, transparencies x 200, envelopes x 40 (GSM weight 85g/m2).

*19: Postcards x 210, transparencies x 360.

*20: Postcards x 210.

*21: Does not include compensation operations.

*22: Device service life depends on the customer's use conditions.
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Network interface specifications

zz Basic specifications
Network protocols

zz For TCP/IP

zz For EtherTalk

zz Connectors
1000BASE-T / 100 BASE-TX / 10 BASE-T (Auto switching and simultaneous use are not possible)

Note

zz The default factory setting is to disable 1000BASE-T.  
If using with 1000BASE-T, use the control panel to make the following settings.  
Set to [Administrator menu]> [Enter password> [Network Setup]> Gigabit Network]> [Enable].

zz Cables
Unshielded twist pair cable with EJ-45 connector (category 5e or later)

zz Connector pin array

zz Interface signals

Pin 
No.

Signal 
name

Function

1 TRD+(0) Data 0 sending and receiving (+)

2 TRD-(0) Data 0 sending and receiving (-)

3 TRD+(1) Data 1 sending and receiving (+)

4 TRD+(2) Data 2 sending and receiving (+)

5 TRD-(2) Data 2 sending and receiving (-)

6 TRD-(1) Data 1 sending and receiving (-)

7 TRD+(3) Data 3 sending and receiving (+)

8 TRD-(3) Data 3 sending and receiving (-)
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USB interface specifications

zz Basic specifications
USB (supports Hi-Speed USB)

zz Connectors
B receptacle (female) upstream port

zz Cables
5m max. USB2.0 specifications cable (2m max. recommended)

(Do not use shielded cable wires.)

zz Send mode
Full speed (12Mbps±0.25% max.)

High speed (480Mbps±0.05% max.)

zz Power control
Self-powered device

zz Connector pin array

zz Interface signals

Signal 
name

Function

1 Vbus Power supply 
(+5V)

2 D- For data transfer

3 D+ For data transfer

4 GND Signal ground

Shell Shield
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Dimensions

Plan view

1369mm

699mm

640mm

665mm

Plan view

Side view

Side view

When the (optional) expansion tray unit is mounted

665mm

1152mm

514mm
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10-key pad.................................................29

2-sided documents......................................26

A

Adjusting brightness.............................. 31, 32

Errors................................................35

Air holes....................................................42

Auto..........................................................94

Auto Power OFF Mode

Setup............................................... 118

Switching Time.................................. 119

B

Back button................................................31

Belt unit lever.............................................27

Belt unit lock lever.......................................27

Bonjour................................................ 74, 78

Built-in HDD......................... 31, 32, 33, 54, 82

Button................................................. 28, 29

C

Cable connections........................................63

[CANCEL] button....................................... 122

CANCEL button...........................................31

Cancelling...........................................38, 122

Slot...................................................31

Cancelling OFF mode...................................38

Card authentication............................... 31, 34

Carrying handles................................... 26, 30

Carrying lever....................................... 25, 26

[CLEAR] key...............................................25

color management server..................25, 26, 29

Consumables..............................................46

Toner cartridge....................................46

Consumption power.....................................56

Control panel..............................................28

Customer support........................................25

Customization....................................... 98, 99

D

Detecting Automatically................................93

Dimensions............................................... 139

Documents.................................................25

Driver installation........................................61

Mac OS X...........................................74

Windows............................................65

E

Envelopes...................................................26

Environment conditions................................62

EPS data....................................................62

Error screen................................................34

EtherTalk.............................................. 74, 75

Expansion tray unit................................ 50, 82

Setup (Mac OS X)................................85

Setup (Windows).................................82

Expansion tray unit with casters.............. 36, 51

F

Face-down stacker.......................................29

Face-down Stacker.................................... 106

Face-up Stacker........................................ 108

Factory settings..................................... 36, 66

Fiery® XF Server Option................................39

Fixing unit .................................................29

Fixing unit jam clearing lever........................29

[Fn] key............................................... 31, 36

Front lamp.................................................25

Function number input screen.......................37

G

Gateway address.........................................65
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Handle.......................................................31

[HELP] button.............................................34

HELP button.......................................... 31, 34

Help screen................................................27

Hubs..........................................................63

I

Image drum...............................................26

Job list......................................... 23, 27

Product warranty, supplying free 

maintenance, and customer  

support..........................................27

Stopper..............................................47

Toner cartridge.............................. 23, 27

Installation.................................................41

Installation environment.......................41

Installation procedure..........................44

Installation space................................41

Relocation..........................................44

Interface

Network interface connector..................26

IP address............................................ 65, 68

J

Japanese double postcard.............................34

L

LAN (network interface connector).................30

LAN cable...................................................63

Connecting.........................................63

Large-capacity expansion tray unit........... 33, 51

LED lamp............................................. 57, 58

Liquid crystal panel................................ 25, 26

Lock lever knob...........................................27

LPD Protocols (TCP/IP)............................... 123

M

Mac OS X printer driver

Documents.........................................31

Main power switch............................25, 57, 58

Power conditions.................................26

Maintenance.................................................2

Manual Feed Printing (Multi-Purpose Tray)...... 101

Menu items.................................................34

Menu items table....................................... 125

Messages...................................................25

Mounting options

Built-in HDD........................................54

Expansion tray unit..............................50

MP paper guide...........................................28

MP Paper Guide......................................... 100

Multi-purpose tray.......................................31

Multi-Purpose Tray.......................... 98, 99, 101

N

Network.....................................................38

Cables................................................63

Setup.................................................69

Network connection

Cannot set up............................... 74, 82

Setting up (Mac OS X)..........................74

Setting up (Windows)...........................65

O

OFF mode

Customization.....................................31

Power save mode................................31

Sleep mode........................................25

[OK] button

[BACK] button............................... 31, 32

Scroll button.......................................31

OK button............................................ 31, 34

Operating environment.................................29

Operating methods...........................25, 31, 32

Output rail unit...........................................29

Output unit knob................................... 26, 29
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Output............................................. 106

Settings....................................... 93, 99

Size...................................................88

Thickness...........................................88

Type..................................................88

Usable Paper.......................................87

Paper cassette...................................... 28, 49

Paper Cassette............................................93

Paper Feed Orientation.................................92

Paper size...................................................25

Paper Size

Setup.................................................98

Paper tray..................................................29

PC	���������������������������������������������������������������3

PCL...........................................................62

PCs

Connecting to the device................ 61, 63

Connecting using LAN cable..................63

Connecting using USB cable..................64

Setting IP addresses............................68

Postcards...................................................27

PostScript fonts...........................................62

Power cable................................................57

Power save

Power save mode.............................. 111

[POWER SAVE] button

Power save key...................................34

Power save mode.......................... 31, 34

Power save mode.................................. 31, 32

Setup............................................... 111

Power supply..............................................56

OFF...................................................58

ON....................................................57

Power supply conditions.......................56

Power switch....................................26, 57, 58

Main power switch......................... 57, 58

Preparations...............................................26

Printer driver..............................................25

Printer drivers.............................................61

Expansion tray (optional)......................82

Mac OS X...........................................74

Types.................................................62

Windows.....................................65, 133

Printer Drivers.....................................94, 101

Printer information................................ 59, 60

Printing................................................ 28, 87

Cancelling......................................... 122

Manual Feed Printing.......................... 104

Paper supporter............................. 28, 29

Printer information......................... 59, 60

Test prints..........................................59

Upper right side cover..........................28

Problems.............................................. 74, 82

PS	������������������������������������������������������������� 62

R

Relocation..................................................44

Remaining toner quantity display...................25

Rendezvous.......................................... 74, 78
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Mac OS X...........................................85
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Setup........................................................41

Network connection....................... 65, 74

Toner cartridge....................................46

USB connections............................ 72, 80

Shutdown...................................................58

Sleep mode

Disabling............................................75

Restrictions....................................... 116

Setup............................................... 113

Switching Time.................................. 114

Slot..................................................... 23, 27

Printing..............................................27

Software DVD-ROM............................... , 3, 61
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Network interface.............................. 137

USB interface.................................... 138

Standby screen...........................................23

Starter toner cartridge........................... 31, 32

Startup screen............................................39

Subnet mask........................................ 65, 67

Support (Customer support).........................23

T

Test prints

Test printing using the printer alone.......59

Toner cartridge............................................46

Toner replacement cover........................ 23, 27

Transfer roller unit securing lever...................29

Tray 1

Tray 1................................................25

Tray information display...............................25

Trays..............................................31, 32, 33

Tray 1.......................................... 49, 93

Trays 2/3/4/5...........................49, 51, 93

Troubleshooting.............................................2

Turning OFF the power automatically..............58

Turning the power OFF automatically............ 118

U

Upper left side cover....................................27

USB cable...................................................64

Connecting................................... 63, 64

USB connections

Cannot set up............................... 74, 82

Setting up (Mac OS X)..........................80

Setting up (Windows)...........................72

USB interface connector...............................64
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Use...........................................................31
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Weight.......................................................44

Weight (mass)............................................23
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Oki contact details
Oki Systems (UK) Ltd
Blays House
Wick Road
Egham
Surrey
TW20 0HJ

Tel: +44 (0) 1784 274300
Fax: +44 (0) 1784 274301
http://www.oki.co.uk
Oki Systems Ireland Limited

The Square Industrial Complex
Tallaght
Dublin 24

Tel:+353 (0) 1 4049590
Fax:+353 (0)1 4049591
http://www.oki.ie
Oki Systems Ireland Limited - 
Northern Ireland

19 Ferndale Avenue
Glengormley
BT36 5AL
Northern Ireland

Tel:+44 (0) 7767 271447
Fax:+44 (0) 1 404 9520
http://www.oki.ie

Technical Support for all Ireland:
Tel:+353 1 4049570
Fax:+353 1 4049555
E-mail: tech.support@oki.ie
OKI Systems (Czech and Slo-
vak), s.r.o.

IBC – Pobřežní 3
186 00 Praha 8
Czech Republic

Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk
Oki Systems (Deutschland) 
GmbH

Hansaallee 187
40549 Düsseldorf

Tel: 01805/6544357**
 01805/OKIHELP**
Fax: +49 (0) 211 59 33 45
Website:
www.okiprintingsolutions.de
info@oki.de

**0,14€/Minute aus dem dt. 
Festnetz der T-Com (Stand 
11.2008)
Διανομέας των συστημάτων OKI

CPI S.A1 Rafailidou str.
177 78 Tavros
Athens
Greece

Tel: +30 210 48 05 800
Fax:+30 210 48 05 801
EMail:sales@cpi.gr

 

Kft.

Oki Systèmes (France) S.A.

44-50 Av. du Général de Gaulle
94246 L'Hay les Roses
Paris

Tel:+33 01 46 15 80 00
Télécopie:+33 01 46 15 80 60
Website: www.oki.fr
OKI Systems (Magyarország) 

Capital Square
Tower 2
7th Floor
H-1133 Budapest,
Váci út 76
Hungary

Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu
OKI Systems (Italia) S.p.A.

via Milano, 11,
20084 Lacchiarella (MI)

Tel:+39 (0) 2 900261
Fax:+39 (0) 2 90026344
Website: www.oki.it
OKI Printing Solutions

Platinium Business Park II, 3rd 
Floor
ul. Domaniewska 42
02-672 Warsaw
Poland

Tel:+48 22 448 65 00
Fax:+48 22 448 65 01
Website: www.oki.com.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl
Oki Systems (Ibérica) S.A.

Sucursal Portugal
Edifício Prime -
Av. Quinta Grande 53
7º C Alfragide
2614-521 Amadora
Portugal

Tel:+351 21 470 4200
Fax:+351 21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt
Oki Service 
Serviço de apoio técnico ao
Cliente

Tel: 808 200 197
E-mail : okiserv@oki.pt

i 

Zagorodnoye shosse
117152, Moscow

Tel: +74 095 258 6065
Fax: +74 095 258 6070
e-mail: info@oki.ru
Website: www.oki.ru

Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru
Oki Systems (Österreich)

Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge

Tel: +43 223 6677 110
Drucker Support:
+43 (0) 2236 677110-501
Fax Support:
+43 (0) 2236 677110-502
Website: www.oki.at
OKI Europe Ltd. (Ukraine)

Raisy Opkinoy Street,8
Building B, 2nd Floor,
Kiev 02002
Ukraine

Tel: +380 44 537 5288
e-mail: info@oki.ua
Website: www.oki.ua
OKI Sistem ve Yazıcı Çözümler
Tic. Ltd. Şti.

Harman sok Duran Is Merkezi,
No:4, Kat:6,
34394, Levent
İstanbul

Tel: +90 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr
www.okiprintingsolutions.com.tr
Oki Systems (Belgium)

Medialaan 24
1800 Vilvoorde

Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be
AlphaLink Bulgaria Ltd.

2 Kukush Str.

tel: +359 2 821 1160
fax: +359 2 821 1193
Website: http://bulgaria.oki.com

OKI Europe Ltd. (Russia)
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OKI Printing Solutions

Herstedøstervej 27
2620 Albertslund
Danmark

Adm.: +45 43 66 65 00
Hotline: +45 43 66 65 40
Salg: +45 43 66 65 30
Fax: +45 43 66 65 90
Website: www.oki.dk
Oki Systems (Finland) Oy

Polaris Capella
Vänrikinkuja 3
02600 Espoo

Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809

Oki Systems (Holland) b.v.

Neptunustraat 27-29
2132 JA Hoofddorp

Helpdesk: 0800 5667654
Tel:+31 (0) 23 55 63 740
Fax:+31 (0) 23 55 63 750
Website: www.oki.nl
Oki Systems (Norway) AS

Tevlingveien 23
N-1081 Oslo

Tel:+47 (0) 63 89 36 00
Telefax:+47 (0) 63 89 36 01
Ordrefax:+47 (0) 63 89 36 02
Website: www.oki.no
General Systems S.R.L. (Roma-
nia)

Sos. Bucuresti-Ploiesti Nr. 135.
Bucharest 1
Romania

Tel: +40 21 303 3138
Fax: +40 21303 3150
Website: http://romania.oki.com

Var vänlig kontakta din 
Återförsäljare i första hand, för 
konsultation. I andra hand kontakta
Oki Systems (Sweden) AB

Borgafjordsgatan 7
Box 1191
164 26 Kista

Tel. +46 (0) 8 634 37 00
e-mail:
info@oki.se för allmänna frågor om
Oki produkter

support@oki.se för teknisk support
gällandes Oki produkter

Vardagar: 08.30 - 12.00,
13.00 - 16.00
Website: www.oki.se

Oki Systems (Schweiz)

Baslerstrasse 15
CH-4310 Rheinfelden

Support deutsch +41 61 827 94 81
Support français +41 61 827 94 82
Support italiano +41 061 827 9473
Tel: +41 61 827 9494
Website: www.oki.ch
Oki Data Americas Inc.(United 
States • États-Unis)

2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel: 1-800-654-3282
Fax: 1-856-222-5247
http://WWW.OKIPRINTINGSOLUTIONS.
COM
http://my.okidata.com
Oki Data Americas Inc.(Canada 
• Canadá)

4140B Sladeview Crescent Unit 7 & 8
Mississauga, Ontario
Canada L5L 6A1

Tél: 1-905-608-5000
Téléc: 1-905-608-5040
http://WWW.OKIPRINTINGSOLUTIONS.
COM
Oki Data Americas Inc.(América 
Latina (OTRO))

2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel (Español): 1-856-222-7496
 1-856-222-5276
Fax: 1-856-222-5260
Email: LASatisfaction@okidata.com
Oki Data de Mexico, S.A. de C.V.

Mariano Escobedo #748, Piso 8
Col. Nueva Anzures
C.P. 11590, México, D.F.

Tel: 52-555-263-8780
Fax: 52-555-250-3501
http://WWW.OKIPRINTINGSOLUTIONS.
COM
Oki Data do Brasil, Ltda.

Rua Alexandre Dumas, 2220-80
andar Chácara Santo Antonio
04717-004, São Paulo, SP Brasil

Tel: 55-11-3444-6747 (Grande São 
Paulo)

 0800-11-5577 (Demais 
localidades)

Fax: 5511-3444-3501
e-mail: okidata@okidata.com.br
http://WWW.OKIPRINTINGSOLUTIONS.
COM

Oki Data (Singapore) Pte. Ltd.

438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)

Tel:(65) 6221 3722
Fax:(65) 6594 0609
http://www.okidata.com.sg
Oki Systems (Thailand) Ltd.

1168/81-82 Lumpini Tower,
27th Floor Rama IV Road
Tungmahamek, Sathorn
Bangkok 10120

Tel:(662) 679 9235
Fax:(662) 679 9243/245
http://www.okisysthai.com
Oki Data(Australia) Pty Ltd.

Level1 67 Epping Road, Macquarie 
Park
NSW 2113, Australia

Tel: +61 2 8071 0000
(Support Tel: 1800 807 472)
Fax: +61 2 8071 0010
http://www.oki.com.au
Comworth Systems Ltd.

8 Antares Place Rosedale,
Auckland, 0632 New Zealand

Tel:(64) 9 477 0500
Fax:(64) 9 477 0549
http://www.comworth.co.nz
Oki Data(S) P Ltd. Malaysia Rep

Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia

Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166



www.okiprintingsolutions.com

Oki Data Corporation
4-11-22 Shibaura, Minato-ku,Tokyo 
108-8551, Japan 
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